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IMPORTANT INFORMATION 

Qualified Personnel Notice 
WARNING: The FallTrak II Balance Systems contain no user serviceable parts. Repair of the FallTrak II System 
should only be performed by qualified service personnel. 

Classification Information 
 EMC Certified to: EN 60601-1-2. 
 Class: Type (BF) equipment. 
 CE Conformity to MDD 93/42/EEC. 

Cleaning and Maintenance 
CAUTION: Do not use Benzene, thinner, or any volatile substance to clean the unit as they may leave a permanent 
mark. 

Balance Platform 
 With the system turned OFF, use a lint free cloth damped with a mild detergent or 70% isopropyl alcohol 

to clean all outer surfaces. 

 The user is responsible for disposal of any FallTrak II components per local regulations. 

Foam Pad 
 Antimicrobial coated positioners and table pads are highly resistant to fluid infiltration. In order to 

maintain the original integrity of the coating, you should exercise care in their handling and use. Wipe 
your antimicrobial coated products clean as soon as possible after fluid contact or use. A soft cloth with 
70% isopropyl alcohol or 10% bleach / water solution is recommended. An all-purpose cleaner similar to 
409™ or Windex™ may also be used. Allow antimicrobial coated products to air dry in a flat (natural) 

position and store them in a flat (natural) position at a temperature not to exceed 170 F. 

Assembly and Installation Notes 
 The FallTrak II System can be installed in any Ordinary Location. 

 The FallTrak II Balance system should be placed on a hard, flat and level surface. 

Components 
 FallTrak II Balance Board with USB Cable. 

 FallTrak II Software on DVD 

 FallTrak II Balance User Guide 

Available options 
 Soft Surface with Grid 

Specifications 

Balance Board 

Parameter Value 

Size 18” L x 10.5” W x 2.25” H. 

Weight 8.25 lbs. 

Power USB-powered, 5v, 300 ma. 

Patient weight capacity 330 lb. (150 kg). 

Ratings 
 The FallTrak II System is not intended for use in the presence of flammable anesthetics. 
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 The FallTrak II System is rated for Continuous Operation. 

 Operating Temperature 10 Centigrade to 35 Centigrade. 

 Storage Temperature -10 Centigrade to 55 Centigrade. 

 Operating Relative Humidity 20% noncondensing to 80% noncondensing. 

 Storage Relative Humidity 20% noncondensing to 80% noncondensing. 

 Special cooling is not required for the operation of the FallTrak II. 

 Ordinary protection against ingress of waters must be provided. 

Accessories 
 The FallTrak II must be operated with an ITE (Information Technology Equipment) compliant PC. 

 Only MedTrak VNG approve accessories may be used with the FallTrak II System. 

Symbols 
 

Symbol Definition 

 

Caution 

 

WEES directive 

 

Temperature Limits 

 

Humidity Limits 

 
DC Voltage 

 

Type BF Applied Part 

 

Class II Equipment 

 

Additional Notes/Warnings 
 

Symbol Definition 

 

The user is responsible for disposal of the system in compliance with local regulations. 

 

Note: It is not recommended that the FallTrak II System be changed in any way. If any changes are 
made, adherence to the CE standards becomes the owner’s responsibility, if you have any questions, 
please contact the CSMI Customer Services Department at: (Voice) 347.742.4100 or (FAX) 
718.228.7797 or (e-mail) scott@medtrakvng.com. 

http://en.wikipedia.org/wiki/File:WEEE_symbol_vectors.svg
http://en.wikipedia.org/wiki/File:WEEE_symbol_vectors.svg
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CAUTION: Federal law restricts this device to sale of or on the order of a medical practitioner. When 
prescribed for therapeutic purpose, a physician should clearly define the parameters of use (i.e., total 
work, maximum heart rate, etc.) to reduce the risk of patient injury. 

 

Copyrights and Trademarks 
The software used to operate either system is protected under copyright laws. Any use of the software other than 
its intended use with the FallTrak II Balance system is prohibited. Altering or tampering of the software in any 
manner constitutes an unwarranted use of the system and immediately voids all warranties expressed or implied 
by MedTrak VNG. MedTrak VNG assumes no liability for damaged equipment or harm to any individual as a result 
of malfunction due to tampered software. 
 
FallTrak IIMicrosoft is a trademark and Windows is a trademark of Microsoft Corporation. 
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IMPORTANT PRE-USE CONSIDERATIONS 
 
Read carefully BEFORE operating the FallTrak II Balance System 
 
The FallTrak II System provides a wide variety of choices for overall treatment of your patients. Adhere to the 
following precautions and instructions to ensure optimum patient safety and proper system usage. DO NOT 
operate the system until you fully understand its operation and have either: 

 attended the in-service provided as a service by CSMI, or 

 fully read and understand the documentation provided with the system. 

NOTE: Federal law restricts the use of this device to, or on the order of, a licensed physician or licensed practitioner. 
If you have any questions, please call the MedTrak VNG Technical Services Department at: 347.742.4100.  

 
When using the System, It is the operator's responsibility to: 
 

 take the time to properly instruct all patients especially those who have difficulty following and carrying 
out instructions. It is highly recommended that such patients be continually coached and verbally guided 
throughout the session; 

 closely monitor all patients using the system; 

 ensure that a clinician is ready to assist in case of loss of balance when patients are working with their 
eyes closed; 

 ensure the patient is standing in the center of the platform for optimal operation, 

 position the display so that the patient can look straight at it. This will help ensure good posture during 
the test or exercise session. 

 
Additional instructions: 
 

 A walker can be used as needed for patient’s that require or feel more comfortable with something to 
hold onto if needed. Note: It will be important, however, to indicate a manual support was required on the 
test output. 

 There is a learning curve that must be considered when testing with this device. Clinical research suggests 
practice trials be performed prior to testing. 

 It is highly recommended that the clinician remain with the patient during testing or training. 
 

IMPORTANT: The FallTrak II Balance system provides some compliance to adjust to non-level flooring. Leaning fully 
over the side of the platform can result in the platform tilting up to 3 degrees. 
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FALLTRAK II FallTrak IIINSTALLATION AND SETUP 
IMPORTANT: Install the FallTrak II software before connecting the FallTrak II Balance Platform to the PC. 

Minimum System Requirements 
Parameter Value 

Operating System 32 or 64-bit version of Windows XP Home or Pro, Windows Vista Home, Business or 
Ultimate, Windows7 Home, Premium or Ultimate. 

CPU Type Pentium or Equivalent 

CPU Speed 1.00GHz 

System RAM 1GB 

  

Package Contents 
Item 

FallTrak II Balance Platform 

FallTrak II DVD 

User Manual (hard copy & pdf on DVD 

Installation Procedure 
STEP DESCRIPTION DETAIL 

1 Insert the FallTrak II CD into the CDROM drive of the PC/Laptop. 
The FallTrak II Installation Program should start automatically. If 
not select Start, My Computer and Double Click on the CD Drive 
that contains the FallTrak II Software. 
 
Select Next to accept the default installation settings until the 
software installation process is complete. The last button in the 
process will read Finish. 

 

2 With the FallTrak II CD still in the CDROM drive, plug the Balance 
Platform USB cable into the PC. 

 
3 Found New Hardware Wizard: 

A. When the “Connect to Windows Update” dialog box 
appears, select No, not this time and click the Next 
button to continue. 

B. Continue clicking Next to accept the default installation 
settings until the software installation process is 
complete. 

C. If a message “This software has not passed the Windows 
Logo testing” appears, click the Continue Anyway button. 

The New Hardware Wizard will run a second time. Select the 
same choices as listed in Steps A-C. 

 

4 The FallTrak II Balance Installation is now complete. 
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Overview 
Although functional assessments provide the clinician with a general idea of who may be at risk, they do not 
identify impairments within specific body systems (e.g., motor, sensory) or why the problem exists.  In addition, 
many of these types of assessment are not sensitive to changes that may result following intervention.  The 
FallTrak II Balance System is a static force plate (Force Plate Mode) that can provide objective and quantifiable 
assessments of underlying impairments in the sensory and motor systems. The FallTrak II Balance & Tilt System 
adds a tilt sensor to the basic FallTrak II Balance System allowing both static force (Force Plate Mode) and dynamic 
tilt (Tilt Mode) measurements. These parameters are used in a variety of protocols to evaluate and improve the 
multiple dimensions of balance. This system can be used with a variety of different clinical populations (e.g., 
patients with orthopedic and/or neurologic disorders) in outpatient settings and with individuals experiencing 
postural instability in non-clinical settings (e.g., senior living communities, senior centers, fitness facilities). The 
training capabilities of the FallTrak II System also facilitate the reduction or elimination of impairments that 
contribute to poor balance and mobility.  The real-time biofeedback available will also help your patients/clients 
perform the exercises correctly as a result of the moment-to-moment feedback provided. 
 
 
This manual starts by providing an overview of each feedback display,, followed by the steps to run a CTSIB test, 
and finally a description of each measured parameter and how it is calculated. 
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Feedback Displays 

CTSIB (Force Plate Mode) 

Assessment of Sensory System Impairment Using The mCTSIB 

Purpose of the Test 
A modified version of the Clinical Test of Sensory Interaction in Balance (mCTSIB) (Shumway-Cook & Horak, 1986) 
is employed to evaluate the user’s ability to use different sensory strategies (visual, vestibular, somatosensory) for 
maintaining upright balance. Although this test cannot distinguish between different sensory system impairments, 
it can be used to identify whether the use of sensory information in different sensory environments is normal or 
abnormal by comparing test results to age-based normative data.  
 
The FallTrak II System's mCTSIB normative database includes the results of 261 tests administered to individuals 
aged between 12 and 88 years. Data is grouped in increments of 10 years (12 to 19, 20 to 29, 30 to 39, etc.). In 
addition, the FallTrak II Software's Group Summary program is capable of comparing normative data against the 
test data you collect. 
 

Age Male Female Total Subjects 

12-19 11 15 26 

20-29 10 18 28 

30-39 12 11 23 

40-49 10 13 23 

50-59 10 19 29 

60-69 17 39 56 

70-79 20 75 65 

80-89 4 7 11 

Totals 94 167 261 

Test Protocol 
The full mCTSIB protocol tests the user in each of four different sensory conditions. It is up to the tester to 
determine which sensory conditions should be used to test the user.  The following sensory systems are available 
to the user across the four sensory conditions: 
 

 eyes open, stable surface (EOSS), Visual, Vestibular, Somatosensory; 

 eyes closed, stable surface (ECSS), Vestibular, Somatosensory; 

 eyes open, foam surface (EOFS), Visual, Vestibular; and 

 eyes closed, foam surface (ECFS), Vestibular. 
 
During each sensory condition, the user is required to stand upright and quietly for 10 seconds with feet shoulder 
width apart, arms folded across their chest, and eyes directed forward. The FallTrak II Screen is blank during the 
test so no visual feedback is provided. Trial time is provided on the screen along with an audible signal for the 
tester to start and stop each trial. During each trial, the FallTrak II records the user's center of pressure (COP). 
Based on COP data, the FallTrak II reports the following measured parameters: 
 

Measured Parameter Definition Objective 

Stability Score Indication of stability Reported as a percentage of maximum postural 
stability and compared to an age-based normative 
data value. 
The closer to 100% the better. 
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Path Length The length of the COP trace. The shorter the Path Length the more stable the user 

Average Velocity The average speed of the COP The slower the average velocity the more stable the 
user 

 
One trial for each condition is performed unless the person being tested is unable to maintain balance for the full 
duration of the trial. The test trial is immediately stopped if the person being tested: 
 

 lifts his/her arms off the chest; 

 prematurely opens his/her eyes on the eyes-closed conditions; or 

 requires manual support due to a loss of balance. 
 
If a trial is stopped it can be repeated. It is not recommended to ask a user to attempt a trial more than three 
times. The FallTrak II Software will only report the results from the last attempted trial. If more than one trial is 
attempted it should be noted on the test output. Repeating test trials allows the test administrator to determine 
whether the person being tested can “learn” to maintain balance if repeatedly exposed to the particular sensory 
environment. 

Interpreting the Test Results 
Increased sway or loss of balance observed in the eyes closed, stable surface condition indicates poor use of 
somatosensory inputs for balance, whereas increased sway or loss of balance in the two foam surface conditions 
may indicate poor use of visual-vestibular inputs (i.e., eyes open, foam surface) or vestibular inputs alone (i.e., eyes 
closed, foam surface). Although no cutoff scores have been developed for this test relative to fall risk, the 
information derived from each test condition can be used to determine whether the individual’s ability to use 
sensory inputs for maintaining upright balance is normal or abnormal. For example, abnormal use of sensory 
inputs would be indicated if an individual required two or more trials to successfully maintain balance for the 
allotted time of 10 seconds on any of the four test conditions, or was unable to complete the trials in any or all of 
the test conditions. It is important to understand that increased sway, particularly in the two foam-surface 
conditions, may also be due to lower-body muscle weakness. 
 

Display 

Display Description 

 

 Provide a cursor (magenta ball) and tracing of the patient’s Center 
of Pressure. 

 A count-down timer. 

Report 

Report Description 
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Report Description 

 

 Normative scores (Blue Bars) for the patient Age and Gender. 

 Green Bar: Patient within 1 Standard Deviation of Normative 
Data. 

 Yellow Bar: Patient within 2-3 Standard Deviations of Normative 
Data. 

 Red Bar: Patient > 3 Standard Deviations of Normative Data. 

 Score: The ratio of the patient’s COP Std Dev to 6.25 degrees. 

 NORM: The ratio of the normative group’s COP Std Dev to 6.25 
degrees. 

 

 A tracing of the patients real-time COP during the test. 

 Blue circle: The Std Dev of the patient’s COP. 

 Red circle: The Std Dev of 6.25 degrees.  

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Time The duration (minutes:seconds) of each set. 

Settings 

Display Parameter Definition 

 

Settings 1. Eyes open, firm surface 
2. Eyes closed, firm surface 
3. Visual Conflict, firm surface 
4. Eyes closed, foam surface 
5. Eyes closed, foam surface 
6. Visual Conflict, foam surface 

 
A CTSIB protocol typically uses conditions 1, 2, 4, and 5. 
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Stability (Force Plate Mode or Tilt Mode) 
Stability test measures a patient's ability to stabilize their balance at locations around their neutral position. 
Results are reported as the percent of time a patient holds their COP in each of the eight targets. 

Display 

Display Description 

 

 The current target flashes green when the patient is on-target 
and flashes yellow when they are off-target. 

 A count-down timer displays the remaining time on the current 
target. 

 The targets are selecting in a Clockwise order beginning with the 
target at 12:00. 

 

Report 

Report Description 

 

 A plot of the targets and a tracing of the patient’s COP during the 
test. 

 The Score (percent of time) they were on-target. 

 The Normative value (set will the File, Preferences command). 

 The Difference between the Patent’s Score and the Normative 
value. 

Options 

Termination 

Display Parameter Definition 

 
Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Settings 

Display Parameter Definition 

 

Level Distance (degrees) to the center of the farthest target. 

Hold Time Time in seconds the patient should remain on the target. Note: The FallTrak II 
counts-down the Hold Time so the patient knows when they should move to the 
next target. 
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Mobility (Force Plate Mode or Tilt Mode) 
Mobility is used to test a patient's ability to hold their Center of Pressure on moving target that circles around a 
patient's neutral balance point. Results are reported as the percent of time a patient holds their COP inside the 
moving target. 

Display 

Display Description 

 

 The current target flashes green when the patient is on-target 
and flashes yellow when they are off-target. 

 A count-down timer displays the remaining time in the test. 

Report 

Report Description 

 

 A plot of the target track and a tracing of the patient’s COP during 
the test. 

 The Score (percent of time) they were on-target. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Time The time (minutes:seconds) for the target to complete one revolution (one set). 

Settings 

Display Parameter Definition 

 Level Distance (degrees) to the center of the farthest target. 
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Stability Envelope (Force Plate Mode or Tilt Mode) 

Assessment of Motor Impairments Using the Stability Envelope Test (SE) 
The LOS Test described above provides the user with symmetrically spaced targets. If the user has an obvious 
deficit in one or more directions, the Stability Envelope Test may be more useful in documenting the user's region 
of stability and the type of postural strategy (i.e., ankle or hip) used to achieve maximal lean. The average 
individual can lean 8 degrees to the left, 8 degrees to the right, 8 degrees anterior, and 4 degrees posterior. 

Purpose of the Test 
This test measures how far individuals are able to lean through their region of stability in multiple directions and 
without altering the base of support (feet flat, no bending at hips, arms across chest). 

Testing Protocol 
The average individual can lean 8 degrees to the left, 8 degrees to the right, 8 degrees anterior, and 4 degrees 
posterior. The Stability Envelope asks the user to demonstrate how far they can lean in eight directions. When the 
user reaches a maximum degree of lean, the operator clicks on the user's on-screen COP to record the degree 
angle. 
 
The test begins with the user's COP centered on the screen and an arrow indicating the direction the user should 
lean with feet maintaining balance, and arms folded across chest. The user leans in the direction of the arrow until 
they reach their maximum lean angle. The operator marks that point (by clicking the mouse or utilizing the touch 
screen), the point is recorded, and the arrow moves to the next position. The user leans in the direction of the 
arrow again (do not return to center). This test is completed when an octagon representing the user’s Area of Lean 
is completed. 

Interpreting the Test Results 
The Stability Envelope Test measures the user's ability to lean (degrees) in each direction and their stability 
envelope (as defined by the area of the octagon). Normal lean angles are 8 degrees to the left, 8 degrees to the 
right, 8 degrees anterior, and 4 degrees posterior. This test documents the user's capabilities so the operator can 
investigate demonstrated inequities. Over time, improved angles of lean and increasing stability indicate 
improvement. 
 

Display 

Display Description 

 

 An arrow shows the current direction the patient should lean. 

 The magenta cursor shows the patient’s location. 

 When the therapist clicks on the dot, the FallTrak II records the 
mouse position and progresses to the next location. 

 A count-up timer displays the total time. 
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Report 

Report Description 

 

 A plot of the stability envelope (based on the locations recorded 
by the mouse clicks). 

 A tracing of the patient’s COP during the test. 

 The Tilt Length (degrees of patient tilt) in each direction. 

 The Tilt Angle (orientation degrees) 

 The Area of the section from the current direction to the next 
direction in the sequence. 

Options 

Termination 

Display Parameter Definition 

 
Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 
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Weight Bearing (Force Plate Mode) 
Display the Patient’s Right/Left or Anterior/Posterior weight distribution. 

Display 

Display Description 

 
 

 

Right/Left 

 A pair of bars showing the patient’s Right/Left Weight 
Distribution. 

 The Right/Left Percent or Weight value. 

 A count-down timer (if a Duration time is selected) or a count-up 
timer (if an Unlimited Duration is selected). 

 
 
 
 
 
 
Anterior/Posterior 

 A pair of bars showing the patient’s Anterior/Posterior Weight 
Distribution. 

 The Anterior/Posterior Percent or Weight value. 

 A count-down timer (if a Duration time is selected) or a count-up 
timer (if an Unlimited Duration is selected). 

Report 

Report Description 

 

 A tracing of the patient’s COP during the test. 
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Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Time The time (minutes:seconds) for the target to complete one revolution (one set). 

Mode and Action 

Display Parameter Definition 

 

> Display the Patient’s Right/Left weight bearing. 

/\ Display the Patient’s Anterior/Posterior weight bearing. 

Settings 

Display Parameter Definition 

 
Display % Display the percent R/L or A/P values below the feedback bars. 

Display Weight Display the weight (pounds or KG) values below the feedback bars. 
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Weight Bearing XY (Force Plate Mode) 
Display the Patient’s Right/Left and Anterior/Posterior weight distribution. 

Display 

Display Description 

 

 X and Y bars showing the patient’s Right/Left and 
Anterior/Posterior Distribution. 

 The Percent value. 

 A count-down timer (if a Duration time is selected) or a count-up 
timer (if an Unlimited Duration is selected). 

Report 

Report Description 

 

 A tracing of the patient’s COP during the test. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Time The time (minutes:seconds) for the target to complete one revolution (one set). 
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Weight Shift (Force Platform Mode and Tilt Mode) 
Weight Shift measures a patient's ability to shift their COP from right to left, anterior to posterior, or in between 
without going outside the target zone. Results measure good hit to bad hit ratio and time needed to complete the 
exercise. 

Display 

Display Description 

 

 The target for the patient to move through in green. 

 A Magenta Boundary the patient must stay within. 

 Their Score (Hits, Misses, Percent). 

 The number of Reps completed and the total number of Reps. 

 The number of Sets completed and the total number of Sets. 

 A count-up timer. 

 
The goal is for the patient to move through the green maker in the correct direction while staying inside the 
magenta boundaries. If they stay within the boundaries a hit is scored (Error! Reference source not found.). If they 
move outside the boundaries a miss is scored (Figure 2). The patient must move through the marker in the correct 
direction for the system to move to the opposite marker. If the pass through in the wrong direction the same 
marker will stay green until they pass through in the correct direction (Figure 3). This would also be a miss since 
the patient went outside the magenta boundaries. 
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Hit Miss Wrong Direction 

 
Figure 1 Hit 

 

 
Figure 2 Miss 

 
Figure 3 Wrong Direction 

Report 

Report Description 

 

 The target display. 

 A tracing of the patient’s COP during the test. 

 Their Score (Hits, Misses, Percent). 

 The Total Time to complete the test. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Reps The number of repetitions. (A repetition is counted when the patient passes 
through either target). 

Settings 

Display Parameter Definition 

 

Left Target Distance (degrees) from the center to the Left target. 

Right Target Distance (degrees) from the center to the Right target. 

Boundary Total width (degrees) of the area the patient must stay within. 

Rotation Rotation (degrees) of the display. 0: Horizontal, 90: Vertical. 
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Center of Pressure (COP) (Force Plate Mode or Tilt Mode) 
Center of Pressures is used to measure the variation in a patient's center of pressure during exercise. 
Display the Patient’s Right/Left and Anterior/Posterior weight distribution. 

Display 

Display Description 

 

 A trace of the patient’s Center of Pressure. 

 A count-down timer (if a Duration time is selected) or a count-up 
timer (if an Unlimited Duration is selected). 

Report 

Report Description 

 

 A tracing of the patient’s COP during the test. 

 The percent of time the patient spent in each Ring and each 
Quadrant. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Time The time (minutes:seconds) for the target to complete one revolution (one set). 
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Limits of Stability (LOS) (Force Plate Mode or Tilt Mode) 

Assessment of Motor Impairments Using the Limits of Stability Test (LOS) 
Possible motor impairments related to the voluntary planning and execution of movements can be identified using 
the Limits of Stability Test. This test provides the operator with information about the size of each individual’s 
region of stability and the type of postural strategy (i.e., ankle or hip) used to achieve maximal lean. From a 
functional perspective, the ability to voluntarily move the Center of Mass (COM) to positions within the limits of 
stability is fundamental to the successful performance of mobility tasks such as reaching for objects, transferring 
from a seated to standing position, and walking. The average individual can lean 8 degrees to the left, 8 degrees to 
the right, 8 degrees anterior, and 4 degrees posterior. 

Purpose of the Test 
This test measures how far individuals are able to lean through their region of stability in multiple directions 
without altering the base of support (feet flat, arms across chest). Also evaluated is how quickly and directly 
individuals are able to lean through their limits of stability. 

Testing Protocol 
The average individual can lean 8 degrees to the left, 8 degrees to the right, 8 degrees anterior, and 4 degrees 
posterior. The posterior target is also set to 1/2 the distance of the anterior target. “Degrees” refers to the extent 
that the patient is leaning with feet flat and no losing balance. The Limits of Stability Test begins with the user's 
COP icon on the center target (representing the neutral position) and eight additional targets circling the center 
target. The user is instructed to move the small pink circle icon, presenting their COP, away from the highlighted 
center and in the direction of the highlighted outer target by leaning as quickly and directly towards the target as 
possible. It will be important to instruct users to only lean as far as they safely can and without losing balance.  This 
is repeated until all of the targets have been reached. If a user cannot reach a target, the tester must press the Skip 
button. 
 
The tester can adjust the LOS protocol by degrees (distance between the center and perimeter targets) and by the 
amount of time the user is required to remain on the highlighted target in order to demonstrate control/stability. 
It is recommended that the tester use a protocol of 8 degrees. . For training users can start with a small degree 
setting and increase the setting as they successfully completes a protocol. For example, begin with 3 degrees and 
with a 1-second hold; if completed successfully continue to 4 degrees with a 1-second hold until the user is not 
able to reach all of the perimeter targets. The FallTrak II Software allows you to build protocols with sets 
containing increasing levels of difficulty. 

Interpreting the Test Results 
The LOS Test measures the user's ability to lean through their stability limits (degrees). The FallTrak II reports a 
Stability Score (ratio between the distance the patient moved and a straight line) and average velocity. The 
inability to reach a target or a poor stability score relative to the other target scores could be an indication of 
limited Range-of-Motion, strength, or motor control in that direction.. A poor stability score in all directions may 
be an indication of poor neuromuscular control. 

Display 

Display Description 
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 The current target flashes green when the patient is on-target 
and flashes yellow when they are off-target. 

 A count-up timer displays the total test time. 

 The targets are selecting in a random order. 

 The patient must return to the center target after each outer 
target. 

 A Skip Target button if the patient cannot reach the current 
target. Note: You cannot skip the center target because the report 
shows how well the patient moved from the center to an outer 
target. 

Report 

Report Description 

 

 The target locations. 

 A tracing of the patient’s COP during the test. 

 The Score (ratio between the distance the patient moved and a 
straight line. See Limits of Stability Score). 

 The Normative value (set with the File, Preferences command). 

 The Difference between the patient’s Score and the Normative 
value. 

 The Time (minutes:seconds) required for the patient to complete 
each target. 

Options 

Termination 

Display Parameter Definition 

 
Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Settings 

Display Parameter Definition 

 

Level The distance (degrees) to the farthest target. 

Hold Time The time (seconds) the patient must remain on each target before progressing 
to the next target. 
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Targets (Force Plate Mode or Tilt Mode) 
Place targets at specific locations which the patient must reach. After reaching each target, the patient must return 
to a neutral position. 

Display 

Display Description 

 

 Click on a blank area to add a target. Patients will be required to 
progress through the targets in the order they are added to the 
screen. Note: The patient’s Range of Motion is displayed as a red 
boarder. Targets should be placed within this area. 

 Click on an existing target to remove it from the screen. 

 After all targets are placed, click Go to begin the test. The targets 
cannot be changed once the test begins. 

 The current target flashes green when the patient is on-target 
and flashes yellow when they are off-target. 

 A count-up timer displays the total test time. 

 The targets are selecting in the order they are placed on the 
screen by the therapist. 

 The patient must return to the center after each target is 
reached. 

Report 

Report Description 

 

 A plot of the targets and a tracing of the patient’s COP during the 
test. 

 The targets are numbered in the order they were selected during 
the test. 

 The Score (percent of time) they were on-target. 

 The Normative value (set will the File, Preferences command). 

 The Difference between the Patent’s Score and the Normative 
value. 

 The Time (minutes:seconds) to reach each target. 

Options 

Termination 

Display Parameter Definition 

 
Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Settings 

Display Parameter Definition 

 

Hold Time Time in seconds the patient should remain on the target. Note: The FallTrak II 
counts-down the Hold Time so the patient knows when they should move to the 
next target. 
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Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
1. Have the patient stand in a neutral position. 
2. Click the start button. 
3. Have the patient lean R/L and A/P. 
4. Click the Stop button. 
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Random Motion (Force Plate Mode or Tilt Mode) 
Provide a randomly moving target for the patient to follow. 

Display 

Display Description 

 

 Provide a randomly moving target for the patient to follow. 

 Their score is the percent of time they were on the target. 

 If a Time is specified, the Timer counts-down, otherwise it counts 
up. 

 A red box indicates the patient’s Range of Motion. The target 
moves randomly within this space. 

Report 

Report Description 

 

 Display a tracing of the patient’s movement during the exercise. 

 The Score is the percent of time they were on-target. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Time The duration (minutes:seconds) of each set. 

Settings 

Display Parameter Definition 

 

Speed The speed the target moves around the screen. 
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Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
5. Have the patient stand in a neutral position. 
6. Click the start button. 
7. Have the patient lean R/L and A/P. 
8. Click the Stop button. 
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Force vs. Time (Force Plate Mode) 
Force vs. Time plot used to measure a patient's single leg isometric weight bearing capabilities. Test Results display 
curves of the patient’s force vs. time. 

Display 

Display Description 

 

 The real-time force vs. time plots. 

 A cursor (dot) showing the patient’s current force (Pounds or KG). 

 The cursor is green if the patient is within the Display Target 
range and red if they are outside the range. 

 The Peak Force during the test. 

 The current Rep and Number of Reps. 

 The current Set and Number of Sets. 

 A count-up timer showing the total test time. 

 

In Target Range Out Of Target Range 

 
Figure 4 Force in Target  

Figure 5 Force Out of Target 

Report 

Report Description 

 

 Display the patient’s Force vs. Time plots. 

 The Peak Force, Average Force, Peak Force Slope, Time to Half 
Peak Force and Time to Peak Force. 
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Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Reps The number of repetitions to perform. 

Settings 

Display Parameter Definition 

 

Hold Time Time (seconds) the patient should exert force on the platform for each 
repetition 

Relax Time Time (seconds) at the end of each repetition 

Force 
Threshold 

Minimum force the patient must meet for the Hold Time to begin 

Display Targets Display minimum/maximum force targets for the patient to achieve. Note: You 
can move the force targets by clicking and dragging them with the mouse. 

Freeze Display Stop the Hold Time counter if the patient is not within the Targets. 

Force Limits 

Note: If Display Targets is not selected, Force Limits are not used. 

Display Parameter Definition 

 

Delete Clear the force limits. 

Scale The red-marker indicates the current force on the balance platform. The green 
band indicates the upper and lower force limits. To have the patient load one 
leg at 50 to 60% of their body weight, set the Lower to 50% and the Upper to 
60% and have the patient step on to the platform to measure their body 
weight. 

Upper % The percent of the maximum force used for the Upper Display Target. For 
example if you were exercising the patient involved side and wanted them to 
limit their force to 50% of their body weight you would have them stand on the 
platform to record the weight, set the Upper% to 50% and enable Display 
Targets and Freeze Display if Outside Target. 

Lower% The percent of the maximum force used for the Lower Display Target. For 
example if you were exercising the patient involved side and wanted them to 
achieve a minimum of 25% of their body weight you would have them stand on 
the platform to record the weight, set the Lower% to 25% and enable Display 
Targets and Freeze Display if Outside Target. 
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Scale (Force Plate Mode) 
Show the patient’s force on the platform using a scale display. 

Display 

Display Description 

 

 A real-time pointer of the Force. 

 A lazy arm showing the Peak Force for the current repetition. 

 A Yellow band indicating the Forces below the Lower Target. 

 A Green band indicating Forces in the Target range. 

 A Red band indicating the Forces below the Lower Target. 

 The pointer color indicates if the force is Below, In, or Above the 
Target Range. 

 The current Rep and Number of Reps. 

 The current Set and Number of Sets. 

 A count-up timer showing the total test time. 

Report 

Report Description 

 

 Display the patient’s Force vs. Time plots. 

 The Peak Force, Average Force, Peak Force Slope, Time to Half 
Peak Force and Time to Peak Force. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Reps The number of repetitions to perform. 
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Settings 

Display Parameter Definition 

 

Hold Time Time (seconds) the patient should exert force on the platform for each 
repetition 

Relax Time Time (seconds) at the end of each repetition 

Force 
Threshold 

Minimum force the patient must meet for the Hold Time to begin 

Display Targets Display minimum/maximum force targets for the patient to achieve. Note: You 
can move the force targets by clicking and dragging them with the mouse. 

Freeze Display Stop the Hold Time counter if the patient is not within the Targets. 

Force Limits 

Note: If Display Targets is not selected, Force Limits are not used. 

Display Parameter Definition 

 

Delete Clear the force limits. 

Scale The red-marker indicates the current force on the balance platform. The green 
band indicates the upper and lower force limits. To have the patient load one 
leg at 50 to 60% of their body weight, set the Lower to 50% and the Upper to 
60% and have the patient step on to the platform to measure their body 
weight. 

Upper % The percent of the maximum force used for the Upper Display Target. For 
example if you were exercising the patient involved side and wanted them to 
limit their force to 50% of their body weight you would have them stand on the 
platform to record the weight, set the Upper% to 50% and enable Display 
Targets and Freeze Display if Outside Target. 

Lower% The percent of the maximum force used for the Lower Display Target. For 
example if you were exercising the patient involved side and wanted them to 
achieve a minimum of 25% of their body weight you would have them stand on 
the platform to record the weight, set the Lower% to 25% and enable Display 
Targets and Freeze Display if Outside Target. 
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Tilt (Force Plate Mode or Tilt Mode) 
Shows the platform tilt in the Right/Left and Anterior/Posterior planes. 

Display 

Display Description 

 

 Real-time pointers of the Tilt. 

 Lazy arms showing the maximum tilt in each direction. 

 A count-up timer showing the total test time. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Time The duration (minutes:seconds) of each set. 
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Roadway (Force Plate Mode or Tilt Mode) 
Roadway can be used to measure a patient's ability to weight shift ((Force Plate Mode or Tilt Mode)) or load the 
involved limb ((Force Plate Mode). Test results report the accuracy of the patient's ability to weight shift or load 
their limb. 

Display 

Display Description 

 

 The goal is for the patient to keep the round cursor between the 
roadway boundaries. (on-target). 

 In COP mode, the ball position corresponds to the patient's COP 
in the R/L or A/P plane. The Y-Axis displays the percent of the 
patient’s total ROM. 

 In Force mode, the ball position corresponds to the patient's force 
production. The Y-Axis displays the percent of the patient’s target 
force. 

 A green ball color indicates the patient is on-target, a red ball 
color indicates they are not on-target. 

 The Score dials indicate the percent of time the patient was on-
target during the Concentric and Eccentric phases of the exercise. 

 The display shows the target in Magenta, the current repetition in 
yellow and the previous 9 repetitions in gray. 

 Pause/Continue buttons to freeze, un-freeze the display. This 
allows you to instruct the patient if they have questions on the 
display. 

 The Accuracy area shows the number of repetitions where the 
patient was within (green light) or below (red light) the target 
accuracy set in the Protocol for both the Concentric and Eccentric 
contraction. If the patient has three repetitions where either the 
Concentric or Eccentric score is below the Accuracy setting the 
display is halted. 

Report 

Report Description 

 

 Display the patient’s COP or Position vs. Time overlaide on the 
roadway. 

 The Peak Force, Average Force, Peak Force Slope, Time to Half 
Peak Force and Time to Peak Force. 
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Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Reps The number of repetitions to perform. 

Mode and Action 

Display Parameter Definition 

 

COP Display feedback based on the patient’s Center of Pressure. 

> Exercise the Patient in the Right/Left plane. 

/\ Exercise the Patient in the Anterior/Posterior plane. 

Force Display feedback based on the patient’s Force on the platform. 

Settings 

Display Parameter Definition 

 
Profile The Roadway Pattern. Note: You can customize the patterns with the Utilities, 

Interactive Feedback Editor command. 

Level The width of the Roadway. 

Accuracy The percent on-target the Con and Ecc phases of a repetition must be to count 
as a “good rep”. Note: Set this value to 0 if you do not want the FallTrak II to 
track accuracy. 

Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
1. Have the patient stand in a neutral position. 
2. Click the start button. 
3. Have the patient lean R/L and A/P. 
4. Click the Stop button. 
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Force Limits 

Note: If Display Targets is not selected, Force Limits are not used. 

Display Parameter Definition 

 

Delete Clear the force limits. 

Scale The red-marker indicates the current force on the balance platform. The green 
band indicates the upper and lower force limits. For example, to have the 
patient load one leg at 50 to 60% of their body weight, set the Lower to 50% 
and the Upper to 60% and the patient step on to the platform to measure their 
body weight. 

Upper % The percent of the maximum force used for the Upper Display Target. For 
example if you were exercising the patient involved side and wanted them to 
limit their force to 50% of their body weight you would have them stand on the 
platform to record the weight, set the Upper% to 50% and enable Display 
Targets and Freeze Display if Outside Target. 

Lower% The percent of the maximum force used for the Lower Display Target. For 
example if you were exercising the patient involved side and wanted them to 
achieve a minimum of 25% of their body weight you would have them stand on 
the platform to record the weight, set the Lower% to 25% and enable Display 
Targets and Freeze Display if Outside Target. 
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Pong (Force Plate Mode or Tilt Mode) 
Pong has the patient play a tennis-like game against the computer. 

Display 

Display Description 

 

 The tennis-like display with Player and Computer paddles. 

 The Player and Computer score. 

 Controls to adjust the Paddle Size, Ball Speed and Ball 
Acceleration. 

Report 
Reports are not available for the games. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Nbr Balls The number of balls to play. 

Mode and Action 

Display Parameter Definition 

 

COP Display feedback based on the patient’s Center of Pressure. 

> Exercise the Patient in the Right/Left plane. 

/\ Exercise the Patient in the Anterior/Posterior plane. 

Force Display feedback based on the patient’s Force on the platform. (Force Plate 
Mode) 

Settings 

Display Parameter Definition 

 
Ball Speed Ball Speed from 1 (Slowest) to 25 (Fastest). 

Ball Accel Ball Acceleration (change in speed) after each paddle strike from 0 (No 
Acceleration) to 10 (Maximum Acceleration). 

Ball Size Ball Size from 1 (Smallest) to 3 (Biggest). 

Ball Rest Rest time (seconds) before each Ball launch. 

Computer Skill Computer Skill playing against the patient from 0 (Beginner) to 100 (Expert). 

Paddle Size The patient’s paddle size from 1 (Smallest) to 10 (Biggest). 
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Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
5. Have the patient stand in a neutral position. 
6. Click the start button. 
7. Have the patient lean R/L and A/P. 
8. Click the Stop button. 

Force Limits (Force Plate Mode) 

Note: If Display Targets is not selected, Force Limits are not used. 

Display Parameter Definition 

 

Delete Clear the force limits. 

Scale The red-marker indicates the current force on the balance platform. The green 
band indicates the upper and lower force limits. For example, to have the 
patient load one leg at 50 to 60% of their body weight, set the Lower to 50% 
and the Upper to 60% and the patient step on to the platform to measure their 
body weight. 

Upper % The percent of the maximum force used for the Upper Display Target. For 
example if you were exercising the patient involved side and wanted them to 
limit their force to 50% of their body weight you would have them stand on the 
platform to record the weight, set the Upper% to 50% and enable Display 
Targets and Freeze Display if Outside Target. 

Lower% The percent of the maximum force used for the Lower Display Target. For 
example if you were exercising the patient involved side and wanted them to 
achieve a minimum of 25% of their body weight you would have them stand on 
the platform to record the weight, set the Lower% to 25% and enable Display 
Targets and Freeze Display if Outside Target. 
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Breakout (Force Plate Mode or Tilt Mode) 
Breakout has the patient move a paddle to knock blocks out of a wall. 

Display 

Display Description 

 

 The breakout display with the Player paddle. 

 The Player Score (blocks destroyed). 

 The number of Balls left. 

 Controls to adjust the Paddle Size, Ball Speed and Ball 
Acceleration. 

Report 
Reports are not available for the games. 

Options 

Termination 

Display Parameter Definition 

 

Sets Number of sets to perform 

Set Rest Rest period (seconds) at the end of each set 

Nbr Balls The number of balls to play. 

Mode and Action 

Display Parameter Definition 

 

COP Display feedback based on the patient’s Center of Pressure. 

> Exercise the Patient in the Right/Left plane. 

/\ Exercise the Patient in the Anterior/Posterior plane. 

Force Display feedback based on the patient’s Force on the platform. (Force Plate 
Mode) 

Settings 

Display Parameter Definition 

 
Ball Speed Ball Speed from 1 (Slowest) to 25 (Fastest). 

Ball Accel Ball Acceleration (change in speed) after each paddle strike from 0 (No 
Acceleration) to 10 (Maximum Acceleration). 

Ball Size Ball Size from 1 (Smallest) to 3 (Biggest). 

Ball Rest Rest time (seconds) before each Ball launch. 

Computer Skill Computer Skill playing against the patient from 0 (Beginner) to 100 (Expert). 

Paddle Size The patient’s paddle size from 1 (Smallest) to 10 (Biggest). 
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Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
9. Have the patient stand in a neutral position. 
10. Click the start button. 
11. Have the patient lean R/L and A/P. 
12. Click the Stop button. 

Force Limits (Force Plate Mode) 

Note: If Display Targets is not selected, Force Limits are not used. 

Display Parameter Definition 

 

Delete Clear the force limits. 

Scale The red-marker indicates the current force on the balance platform. The green 
band indicates the upper and lower force limits. For example, to have the 
patient load one leg at 50 to 60% of their body weight, set the Lower to 50% 
and the Upper to 60% and the patient step on to the platform to measure their 
body weight. 

Upper % The percent of the maximum force used for the Upper Display Target. For 
example if you were exercising the patient involved side and wanted them to 
limit their force to 50% of their body weight you would have them stand on the 
platform to record the weight, set the Upper% to 50% and enable Display 
Targets and Freeze Display if Outside Target. 

Lower% The percent of the maximum force used for the Lower Display Target. For 
example if you were exercising the patient involved side and wanted them to 
achieve a minimum of 25% of their body weight you would have them stand on 
the platform to record the weight, set the Lower% to 25% and enable Display 
Targets and Freeze Display if Outside Target. 
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Balance Board (Force Plate Mode or Tilt Mode) 
Two-dimensional balance game where player must tilt the board (by leaning R/L, A/P) to move the ball through a 
maze and into the target hole. 12 levels of increasing difficulty are available. 

Display 

Display Description 

 

 The Balance Board Display. 

 A count-up timer of the total time played. 

 The current level. 

 A Menu button. 

Report 
Reports are not available for the games. 

Options 

Menu 

Display Description 

 

 Level: Select the Level to play and begin the game. 

 Play: Display the Levels. 

 Player: Select the player. 

 Scores: View the current player’s scores. 

 Help: Display Help System. 

 Quit: Return to the Dashboard. 

Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
1. Have the patient stand in a neutral position. 
2. Click the start button. 
3. Have the patient lean R/L and A/P. 
4. Click the Stop button. 
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Skier (Force Plate Mode or Tilt Mode) 
Two-dimensional ski-race game where patient must ski down a course. The patient’s Right/Left tilt controls the 
skier’s Right/Left position. The patient’s Anterior/Posterior tilt controls the skier’s speed. 12 levels of increasing 
difficulty are available. 

Display 

Display Description 

 

 The Skier Display. 

 The patient leans Right/Left to steer the skier. 

 The patient leans Anterior/Posterior to increase/decrease the 
skier’s speed. 

 A count-up timer of the total time played. 

 The current level. 

 A Menu button. 

Report 
Reports are not available for the games. 

Options 

Menu 

Display Description 

 

 Level: Select the Level to play and begin the game. 

 Play: Display the Levels. 

 Player: Select the player. 

 Scores: View the current player’s scores. 

 Help: Display Help System. 

 Quit: Return to the Dashboard. 

Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
1. Have the patient stand in a neutral position. 
2. Click the start button. 
3. Have the patient lean R/L and A/P. 
4. Click the Stop button. 
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Snowboarder (Force Plate Mode or Tilt Mode) 
Two-dimensional snowboard-race game where patient must ski down a course. The patient’s Anterior/Posterior 
tilt controls the snowboarder’s Right/Left position. The patient’s Right/Left tilt controls the skier’s speed. 12 levels 
of increasing difficulty are available. 
 
Note: The balance platform should be oriented so the player’s front foot is toward the display and the USB cable 
exits the board in front of the player. 

Display 

Display Description 

 

 The Snowboarder Display. 

 The patient leans Right/Left to steer the snowboarder. 

 The patient leans Anterior/Posterior to increase/decrease the 
snowboarder’s speed. 

 A count-up timer of the total time played. 

 The current level. 

 A Menu button. 

Report 
Reports are not available for the games. 

Options 

Menu 

Display Description 

 

 Level: Select the Level to play and begin the game. 

 Play: Display the Levels. 

 Player: Select the player. 

 Scores: View the current player’s scores. 

 Help: Display Help System. 

 Quit: Return to the Dashboard. 

Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior. (Balance Mode) 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
1. Have the patient stand in a neutral position. 
2. Click the start button. 
3. Have the patient lean R/L and A/P. 
4. Click the Stop button. 

Mode and Action 

Display Parameter Definition 

 

Mode Select if the Snowboarder is Regular (left foot forward) or Goofy (right foot 
forward. 
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Pilot (Force Plate Mode or Tilt Mode) 
Three-dimensional flight-race game where patient must fly through targets. The patient’s Right/Left tilt controls 
the plane’s Right/Left position. The patient’s Anterior/Posterior tilt controls the plane’s Climb/Descend speed. 12 
levels of increasing difficulty are available. 

Display 

Display Description 

 

 The Pilot Display. 

 The patient leans Right/Left to turn the plane Right/Left. 

 The patient leans Anterior/Posterior to have the plane 
Climb/Descend. 

 A count-up timer of the total time played. 

 The current level. 

 A Menu button. 

Report 
Reports are not available for the games. 

Options 

Menu 

Display Description 

 

 Level: Select the Level to play and begin the game. 

 Play: Display the Levels. 

 Player: Select the player. 

 Scores: View the current player’s scores. 

 Help: Display Help System. 

 Quit: Return to the Dashboard. 

Range of Motion 

Display Parameter Definition 

 

Set AZ Set the patient’s neutral standing position. Ask the patient to stand so they feel 
balanced Right/Left and Anterior/Posterior 

Start/Stop Measure the patient’s maximum R/L and A/P range. 
1. Have the patient stand in a neutral position. 
2. Click the start button. 
3. Have the patient lean R/L and A/P. 
4. Click the Stop button. 
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The Main FallTrak II Screen 
The Main FallTrak II Screen contains a number of components: 
 

 
Figure 6 FallTrak II Form 

 
The Title Bar located at the top of the screen contains the Application Name and Version (FallTrak II Version 
11.001.0016), the machine (Balance) and the current patient (Potash, Robert). 
 

 
Figure 7 Title Bar 

  
 
Just below the title bar is the Menu Bar. You can access all of the FallTrak II functions from the menu bar. Each 
menu item has an underlined character. Holding the Alt key while pressing the underlined character selects the 
menu item. For example Alt-F selects the file menu. 
 

 
Figure 8 Menu Bar 

 
 
The Button Bar contains shortcuts to the most commonly used FallTrak II functions. When the FallTrak II program 
begins, only the Patient, Dashboard, and Help options are available. Selecting a patient enables the Test, Exercise, 
and Report options. 
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Figure 9 Button Bar No Patient Selected 

 

 
Figure 10 Button Bar Patient Selected 

 
 
To the right of the button bar is a real-time display of the Balance data: Weight, Tilt Angle, and Tilt Direction. 
 

 
Figure 11 Real-Time Display 

 
The bottom of the screen contains the Status Bar which displays the current test pattern and system units. The 
system units are displayed for the Force, Position, and Velocity measures. 
 

  
Figure 12 Status Bar 
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Starting FallTrak II Program 

Steps 
1. From the Menu Bar File option, select Preferences. 

Figure 13 Select Machine Type 
2. From the Interface area select USB/COMM (Balance). 

 

Figure 14 Select USB Port 
3. Click the OK button to save your changes. The FallTrak II will default to these settings the next time the 

program is started. 

4. If the FallTrak II Balance drivers are installed and the FallTrak II Balance Board is plugged into the USB 
Port, the following dialog box is displayed. 

 

Figure 15 Warm-up Screen 
5. Insure the platform is sitting on a flat surface and remove all weight from the Platform (no one is standing 

on the Platform). 

6. Click the OK button to read the zero weight. The FallTrak II will return to the Main Menu. 
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Testing a Patient 
The process to test a patient is: 
 

1. Select a Patient. 
2. Select a Test. 
3. Select a Protocol. 
4. Run the Test. 
5. Print a Report. 

 
The following example demonstrates running and printing the results of a CTSIB test. 
 
Note: 

 When using a Balance System any barrier (shoes, socks) between the patient and the FallTrak II Balance 
Board surface may affect their performance. In some situations you may want to remove all barriers. It 
depends on if you want to measure absolute vs. real-world performance. The normative data used in the 
FallTrak II Balance CTSIB Report assumes no shoes with socks. 

 Whichever condition testing you use is your decision. However if you plan to do follow-up comparisons it 
is important to keep all variables the same from test to test. 
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Patient Selection 
The Select a Patient screen allows you to add, edit, or delete patients from the database. 

Steps 
1. From the Main Screen, click the Patient button. 
2. The FallTrak II will display the Patient Selection Screen. 
3. For this example we will add a new patient. Click the New button. 

Screen 

 
Figure 16 Patient Selection 

Actions 

Action Definition 

OK Select the highlighted patient. You can also double-click a patient's name to select them. 

Cancel Cancel the patient selection and return to the main FallTrak II screen. 

Search As you begin typing the patient's last name, the FallTrak II automatically displays patients 
matching the search criteria. 

New Add a new patient to the database. 

Edit Edit the highlighted patient's background information (Name, Height, Weight, etc.). 

Delete Delete the highlighted patient from the FallTrak II Database. IMPORTANT: When you delete a 
patient from the FallTrak II Database, all of their test and exercise data is deleted from the 
system. There is no way to recover deleted data. 

Last Test Repeat the last test run on the patient. The FallTrak II recalls the most recent test run on the 
patient and begins a new test session using the same pattern and protocol. 

Last Exercise Repeat the last exercise run on the patient. The FallTrak II recalls the most recent exercise run on 
the patient and begins a new exercise session using the same pattern and protocol. 

Complete Complete the last test or exercise run on the patient. The FallTrak II recalls the patient's previous 
test and goes directly to the test status screen. This is typically used if you are unable to 
complete the test, e.g. the patient stopped or there was a computer problem. 
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Adding a New Patient 

Steps 
1. The FallTrak II will display a blank patient information screen. The patient information entered here will 

appear at the top of every report for the patient and can be used as filters in the Group 
Summary/Normative Database module. We recommend you complete as many fields as possible when 
adding a new patient. 

2. After adding the patient information click OK to save new Patient information and return to the main 
FallTrak II Screen. The patient name will then appear in the Title Bar and all of the buttons on the Button 
Bar including Test, Exercise, and Report will be active. 

Screen 

 
Figure 17 Patient Information - General 

 
Figure 18 Patient Information – Injury/Group 

Fields 

Field Name Description 

Last, First, Middle Enter Patient name. Press Tab to advance to next field 

ID Patient ID number. 

Height Enter according to the displayed units of measure. Required field. 

Weight Enter according to the displayed units of measure. Required field. 

Gender Required field. 

Preferred Side Patient’s dominant side. 

Involved Side Injured side. 

Tester Name of perform performing the test. The pull-down list attached to this field should be 
edited to include the names of the clinicians using the FallTrak II Balance. 

Diagnosis The pull-down list attached to this field should be edited to include the common 
diagnoses seen. 

Injury Date Pop-up calendar available. 

Surgery This pull-down list attached to this field should be edited to include the common 
surgeries seen 

Doctor The pull-down list attached to this field should be edited to include the names of the 
referring physicians 

Group 1 Extra field to further define the patient. The pull-down list attached to this field can be 
edited. 

Group 2 Second field to further define the patient. The pull-down list attached to this field can 
be edited. 
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Note: 

 Click the Keypad buttons  or  to pop-up a keypad for data entry with a touch-screen monitor. 

 After a patient has been tested, use the Edit Background command to edit the information stored with the 
test. 

 The Patient Selection screen lists the Patient Name and ID. By default the list is sorted by patient name. To 
sort by ID, click on the ID column heading. 

 Only one copy of the patient's Name, ID, Birth Date, and Sex are stored in the FallTrak II database. Any 
changes to these fields will automatically appear on every test and exercise record for the patient. 

 The Height, Weight, Preferred Side, Involved Side, Diagnosis, Injury Date, Surgery, Surgery Date, Doctor, 
Tester, Group1, and Group2 values are stored individually with each test and exercise session run. This 
allows changes to these fields to accurately reflect the patient's condition at the time of the test or 
exercise session. Use the Edit Background (Section 0) command to change the values for a test which has 
already been run. 
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Pattern Selection 

Steps 
1. From the FallTrak II Button Bar, click Test. 
2. The FallTrak II will display the Pattern Selection screen. 
3. The FallTrak II allows tests to be run in a bi-laterally (standing on both feet) or a uni-laterally (standing on 

one foot). 
4. Click on Standing Balance Bilateral row to highlight it. Note: Most Balance Tests are performed Bi-

laterally. 
5. Click OK advance to the Protocol Selection Screen 

Screen 

 
Figure 19 Pattern Selection 

Actions 

Field Name Description 

OK Select the highlighted pattern. You can also double-click a pattern to select it. 

Cancel Cancel the pattern selection and return to the main FallTrak II screen. 
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Protocol Selection 
Protocols are collections of one or more sets which describe the Display, Termination, Rest Period and other test 
parameters. A protocol can contain up to 25 sets. 

Steps 
1. In the Feedback area, select CTSIB. 
2. The FallTrak II will display Termination, Mode and Action and Settings options applicable to the CTSIB 

test. Note: The options for each feedback mode are described in the section titled Error! Reference source 
not found.. 

3. The FallTrak II will load the Protocol area, Select pull-down with all previous CTSIB protocols for this 
patient and all system-wide CTSIB protocols. For this example we will customize the protocol. 

4. In the Termination, Duration area, set the Time to 0:30. 
5. In the Settings area, select Eyes Open Firm Surface and Eyes Closed Firm Surface. 
6. In the Protocol area, Rename the protocol to CTSIB – Firm – Eyes Open/Closed. Note: 

a. The FallTrak II will remember this protocol the next time you test the patient. 
b. Use to Utilities, Protocol Editor to create custom protocols which can be used with all patients. 
c. Use the Select pull-down box to select a pre-defined custom protocol. 

7. Click the OK button to save the Protocol and move to the Test Status screen. 

Screen 

 
Figure 20 Protocol Selection 

Actions 

Field Name Description 

Select The pull-down control displays a list of the protocols the patient has been tested with. The 
patient's most recent protocol at the top of the list. Following the patient's individual protocols, 
the FallTrak II displays the system protocols. System protocols are available to all patients and 
are created using Utilities, Protocol Editor from the Main Screen. 

Rename A text description which is displayed in the Protocol control after the protocol is saved from this 
screen. 

OK Continue with the displayed protocol. 

Cancel Cancel the test/exercise session and return to the main FallTrak II menu. 

Termination The number of sets and reps to be performed. 

Mode and 
Action 

The mode (Center of Pressure or Force) and the direction of the COP. 

Settings The settings for the feedback display. 
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Test Status 
The Test Status screen displays all sets in the protocol and their status (Tested, Not Tested, Error). 

Steps 
1. Click the All Sets button to perform all of the sets in this protocol in sequential order. 

2. The Patient Setup screen will appear. 

Screen 

 
Figure 21 Test Status 

Actions 

Action Definition 

OK Leave the Test Status screen and move to the Report screen. Once you leave the Test Status 
screen you cannot run additional sets from the protocol. 

Side Select the Side which will be tested. Note: The side is not displayed for Bi-lateral patterns. 

Single Set Run the currently highlighted set. 

All Sets Run all sets in the protocol starting with the selected set. Note: When you select All Sets the 
FallTrak II deletes all data from any sets which are run. For example, if you completed all sets 
in a 3 set protocol, select the second set and click All Sets, the FallTrak II will leave the data 
from the first set in-place and replace the data in the second and third set with the new data 
as the sets are re-run. 

Set AZ Re-set the patient’s Foot Position. If you re-set the AZ you should re-run the sets. 

Preview Preview a test report. This allows you to quickly check the results of a set before leaving the 
Test Status screen. 

 
Note: If the patient stops in the middle of a set you may choose to re-run the set. When you re-run a set the 
FallTrak II overwrites the previous data with the new data. 

Status 

Status Definition 

Not Tested The set as not been run yet. 

Tested The set was completed successfully. 

Error An error occurred while running the set, for example, the patient did not go through a full 
range of motion or the clinician aborted the set. 
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Patient Setup 
The Patient Setup screen allows you to record the patient’s foot position on the platform. The foot position is used 

by the FallTrak II to compute the test results. If this setting is correct and the patient is standing in an anatomically 

correct position the patient COP should be centered on the Test Display screen. 

Steps 
1. Use the scales on the FallTrak II Balance Board to record the patient’s foot position. 

a. The Angle is read by comparing the foot angle to the angle display on the FallTrak II board. 

b. The Medial Malleolus is read by selecting the letter row on the FallTrak II board with is closest to 

the Medial Malleolus. 

c. The Heel is read by selecting the number column on the FallTrak II board with is closest to the 

centerline of the heel. 

2. Enter the Angle, Medial Malleolus and Heel positions. 

3. Click the OK button to save the settings. Note: Once these positions are recorded, the patient should not 

move their feet for the duration of the test. 

4. The FallTrak II will display the Anatomical Zero screen. 

Screen 

 

Figure 22 Patient Setup Screen 
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Anatomical Zero 
If the patient setup values are correct and the patient is standing in a perfectly neutral position the patient COP 

should be centered on the Test Display screen. Many times due to body mechanics a patient is not centered even 

thought their foot position is recorded. For this reason there is the option to have the FallTrak II Center the COP 

display. 

Steps 
1. Instruct the patient to stand in a neutral position. 

2. Click the OK button to record this as their Anatomical Zero. 

3. The FallTrak II will move to the Patient Feedback screen. 

Screen 

 

Figure 23 Set Anatomical Zero Screen 
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Move to COP Timer 
Before tests which require the patient to start in the COP, the FallTrak II displays a 5 second “Move to Center of 
Pressure” timer. During this time the patient can see there COP on the display but no data is collected. 

Steps 
1. Instruct the patient to adjust their balance so the COP marker (magenta ball) is in the center of the 

screen. 

Display 

 
Figure 24 Move to COP Timer 
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Patient Feedback (CTSIB Test) 

Steps 
The CTSIB measures the patents ability to hold their Center of Pressure which is where the crosshairs meet on the 

center of the screen. 

1. Instruct the patient to remain as steady as possible. 

2. After the timer counts down the FallTrak II will proceed to the next set. After all sets are completed the 

FallTrak II will return to the Test Status screen. 

Screen 

 
Figure 25 CTSIB Feedback Display (COP) 
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Test Status 
At the conclusion of the test the FallTrak II will return to the Status screen. Notice all of the tests under Status now 

read Tested. 

Steps 
1. Click the OK button. The FallTrak II automatically stores the collected data in the database and proceeds 

to the Report screen. 

Screen 

  

Figure 26 Status Screen - Tests Completed 
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REPORTS 

Single Test Report 
The FallTrak II report screen lists all of the stored test results and report options. Results are listed in chronological 
order with the most recent at the top. When you select a test from the listing grid, the FallTrak II automatically 
populates the reports types for the selected test. 

Steps 
1. From the Listing Grid, click the test to select it. 
2. Click the Preview button to display the test report. 

Screen 

 

Figure 27 Reports Screen 

Actions 

 
Figure 28 Report: Actions 

Status Definition 

Preview Preview the selected report on the screen. 

Print Send the selected report to the printer. 

File Save the selected report to a disk file. 

Type Select the type of report to generate. When you select a report from the listing grid, the 
FallTrak II populates the Type list with all reports which are available for the selected test. 

Delete Delete the selected test from the database. 

Options 

 
Figure 29 Report: Options 
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Options 
The Options section allows you to change how the data is processed and reported for the selected test. 

Status Definition 

Units Display results in US or Metric Units. 

Torque Report the Average Value or Highest Rep for Torque vs. Time and Scale tests. 

Scale Auto-scale or use a fixed scale for Torque vs. Time and Scale tests. 

 
Note: Changes to the options only apply to the current report being generated and do not affect the Preferences. 
Use the File, Preferences command to set the default report options. 
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Progress Report 
The FallTrak II Progress Report screen allows you to select two tests and print a Progress Report showing the initial 
values, the follow-up values and the change which occurred between the two. 

Steps 
1. From Reports menu, select Progress. The FallTrak II will display the Progress Report screen. 
2. From the Listing Grid, select the Initial test and click the Initial button. 
3. From the Listing Grid, select the Follow-up test and click the Follow-Up button. 
4. Click the Preview button to display the report. The FallTrak II will confirm the protocols in the two tests 

match and if so, display the progress report. 

Screen 

 

Figure 30 Progress Report Screen 
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Involved Side Re-Test Report 
The Involved Side Re-test Report allows you to combine the results of an initial test for one side with the results of 
a follow-up test for the other side into a single report. This is typically used when you test both side during an 
initial evaluation and only re-test the involved side during a follow-up visit. 

Steps 
1. From Reports menu, select Involved Re-Test. The FallTrak II will display the Re-Test Report screen. 
2. From the Listing Grid, select the Right Side test and click the Right button. 
3. From the Listing Grid, select the Left Side up test and click the Left button. 
4. Click the Preview button to display the report. The FallTrak II will confirm the protocols in the two tests 

match and if so, display the Re-Test report. 

Screen 

 

Figure 31 Re-Test Report Screen 
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DASHBOARD 
The FallTrak II Dashboard allows you to control the basic functions of the FallTrak II and provide patient feedback 
without running a test or exercise protocol. Reports can be printed but data is not saved when using the 
Dashboard and the Patient’s information does on appear at the top of report. Note: The Dashboard Options are 
explained in detail in “Feedback Displays”. 

Steps 
1. From the Button Bar click the Dashboard button or from the Utilities menu, select Dashboard. 

Screen 

 
Figure 32 Dashboard Screen 

Options 

Status Definition 

Exit Leave the Dashboard 

Go Start the selected Exercise 

Preview Preview a report from the recently completed exercise. 

Print Print a report from the recently completed exercise 

Erase Data Delete the data from the recently completed exercise 

Side 
The Side is used when printing reports. When you select a Feedback Display, the FallTrak II displays Right/Left or 
Bi-Lateral as the side. Certain displays e.g. Force vs. Time allow Uni-lateral testing. In this case you can select 
whether the Right or Left side is being exercised and the data will be correctly reported. 
 
The FallTrak II displays the Status (Tested, No-Tested) indicating if there is data to be printed. 



300921 FallTrak II Balance User Manual.docx  Page 69 of 100 

GROUP SUMMARY 
The FallTrak II Group Summary program computes summary data over various patient populations. Summaries are 
stored in a Group Summary database, allowing the clinic to build a library of summary data results. Reports can be 
printed for a stored group or comparing a patient to the group. 

Computing a Group Summary 
1. From the Group Summary menu, select My Data. 

Adding a New Group Summary to the Database 

Steps 
1. Select the Pattern, e.g. Standing Balance - Bilateral. 
2. Select the Protocol. 
3. Click the Add button. 
4. Enter the Summary name, e.g. CTSIB and click the OK button. 
5. The FallTrak II will add the new summary to the Group Summary Database. 

 
Note: The FallTrak II has added a blank group summary record for the selected pattern and protocol. When you 
click the Summarize button, the FallTrak II reads through the database of tests and populates the group summary 
record. 

Screen 

 
Figure 33 Group Summary: Add 

Computing the Summary 

Setting the Group Criteria 
The Group Summary filter allows you to select which patients will be included in the summary. The following 
example includes patents from 25 to 40 years old when the test was performed with an ACL Tear. Only tests which 
were performed within 31 days of the injury will be included. You can independently specify the From and To 
values, e.g.: 
 

From To Data 

Blank Blank Ignore the field 

Blank 40 All patients <= 40 years old when the test was performed. 

25 Blank All patients >= 25 years old when the test was performed. 

25 40 All patients from 25 to 40 years old when the test was performed. 

Steps 

1. Click the Background button. 
2. Enter the criteria. 
3. Click the OK button to save the criteria. 
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Screen 

 
Figure 34Group Summary: Filter 

Select Tests 

 
Figure 35 Group Summary: Select Tests 

 

Options Definition 

All Tests Include all tests for each patient in the summary. 

Most Recent 
Test 

Include the most recent test for each patient in the summary. This option prevents a patient 
who has been tested multiple times from skewing the results. 

Side 

 
Figure 36 Group Summary: Side 

 

Side Definition 

Right vs. Left Average Right side data vs. Left side data. 

Dominant vs. 
Non-Dominant 

Average Dominant side data vs. Non-Dominant side data. 

Involved vs. 
UnInvolved 

Average Involved side data vs. UnInvolved side data. 

Summarizing the Data 
Click the Summarize button. The FallTrak II will read each test in the database, compute the measured parameters, 
and store them in the Summary Database. 
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Note: 
1. When you change the summary criteria, you must re-summarize the data to compute the results for the 

new group. 

2. When you test additional patients which you want to include in the Group Summary, simply select the 
Stored Summary and click the Summarize button. The FallTrak II will re-compute the summary for all tests 
stored in the database. 

Exporting a Summary to Microsoft Access 
1. From the Group Summary database area, select the Group Summary record you want to Export. 

2. Click the Access button. 

3. The FallTrak II will export the data computed in the Summary to the FallTrak II Results2009.MDB file. Data 
from the Results database can be imported to other applications, e.g. SPSS. 

Group Summary - Access Data Format 
The Group Summary program stores the summarized data in the Results2009.MDB database file. The file is in the 
Access 2000 format. 
 
Results.MDB includes a collection of tables containing the more detailed Patient Information, Dynamometer 
Settings, and Per-repetition values. Advanced users may want to use the Linked Table to perform advanced 
Queries and Data Analysis. 

Tables 

Table Definition 

Protocol Table containing one row for each patient test or exercise session. 

ProtocolRow Table containing the settings for each set (row) in the Protocol. 

Demographics The patient background information for each Protocol. 

Vals The per-repetition values for each row in the ProtocolRow. 

Fields 

Each table include a description of its data fields. To access the field descriptions: 
 

1. Open the Results2015.MDB file with Access. 
2. Single-click the table to select it. 
3. Click the Design icon. 
4. The Description column contains the field description. 

Printing a Summary Report 
1. In the Group Summary database area, select the Group Summary record you want to Preview/Print. 
2. Click the Preview or Print button. 

Comparing a Patient to a Group Summary 
1. From the Main FallTrak II menu, select the Patient. 
2. From the Group Summary menu, select My Data. 
3. In the Group Summary Database area, select the Group Summary record you want to compare the 

patient to. 
4. In the Patient area, select the Patient session you want to compare to the Group Summary. 
5. In the Patient area click the Preview or Print button. 

Deleting a Group Summary 
1. From the Group Summary Database area, select the Group Summary record you want to Delete. 
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2. Click the Delete button. 
Note: Deleting the Group Summary only deletes the summarized results. The original patient tests remain in the 
FallTrak II database. 
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UTILITIES 

Edit Background Information 
The FallTrak II allows you to edit the patient background information for stored tests. This is typically used after 
you complete a test or exercise session and realize the patient's weight, injury, or other information was is 
incorrect. 

Steps 
1. Select the Patient whose data you want to edit. 
2. On the Database menu, click Edit Background. 
3. Click the Test/Exercise record you want to edit. 
4. Click Update to open the patient background information form. 
5. Edit the patient information and click OK to save your changes. 

Screen 

 
Figure 37 Edit Background Information 
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Deleting Stored Tests 
The Database, Delete Record command allows you to delete stored test and exercise records from the database. 

Steps 
1. On the Database menu, click Delete Record. 
2. Click the Test/Exercise record you want to delete. 
3. Click Delete to delete the record. 

 
Note 

 Deleted records cannot be restored. 

 Use the delete function in the patient selection form to quickly delete a patient and all their stored test 
and exercise sessions. 

Screen 

 
Figure 38 Delete Stored Test 

  



300921 FallTrak II Balance User Manual.docx  Page 75 of 100 

Usage Report 
The Usage Report shows each protocol run on the system grouped by patient. The report is sorted first by Patient 
Name, then by the Date the protocol was run. 

Steps 
1. On the File menu, click Usage Report. 

Screen 

 
Figure 39 Usage Report 
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Backup 
We suggest you perform periodic backups to assure your data can be restored in the event of a computer failure. 
You can do a backup via an External File Copy or with the FallTrak II Backup Command. 

Steps 
2. On the File menu, click Backup. 
3. Click Set Backup Destination. 
4. From the Windows File Open dialog box, select the destination for the backup. 
5. Select the Files to Backup. Typically you would select all files. 
6. Click the Backup button. 

 
Note Some sites prefer to use CD-R or CD-RW media for backup. These media require special programs provided 
with the CD drive to write data to the CD. If you will be using the FallTrak II Backup Command you must perform the 
backup to a folder on the computer's hard drive and then use the CD-supplied software to copy the FallTrak II 
Backup.ZIP file to the CD. 

Screen 

 
Figure 40 Backup Database 

External File Copy 
You can create a backup of your FallTrak II data by copying the FallTrak II data files to your backup media, e.g. CD-R 
or tape drive. 

Options 

Options Definition 

Set Backup 
Destination 

During a backup the FallTrak II compresses your data into a file called FallTrak II Backup.ZIP. 
This file can be on floppy disk, a ZIP drive, a local hard drive (which should be different than 
the drive holding the FallTrak II database), or a network. The Set Backup Destination option 
allows you to specify where the backup file will be created. 

Files to Backup The Files to Backup area allows you to select which files will be added to your backup. Typically 
you would select all of the files. 
When contacting CSMI to resolve a question, we may request you only select one type of file 
for backup and then send the backup to CSMI. 

Backup Start the backup. 

Abort Abort the backup currently in progress and delete the backup file. 
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Data File Location 
The FallTrak II database can be stored on your local computer or on a network. 

Steps 
1. On the File menu, click Database, Open. 
2. When the Windows Open File dialog box appears, locate and open your FallTrak II database (User FallTrak 

II.MDB). 
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Compress 
If you make frequent changes in the FallTrak II database, sections of the database may become fragmented. 
Therefore, it is a good idea to periodically compress the database. 
 
Schedule the compression depending on how much the data changes. If the data does not change that often, you 
do not have to compress that much. If there are many and frequent updates, inserts, and deletes, compress more. 
Even though there is no formal rule for how often to compact, Microsoft recommends that you compress on a 
regular basis. 
 
For a detailed description of the compress function, see the Microsoft Knowledge Base article Q209769 ACC2000: 
Defragment and Compact Database to Improve Performance. 

Steps 
1. On the File menu, click Compress. 
2. Click Yes to compress the database. 

 
Note During the compress function the mouse pointer will change to an hourglass. Because the compress function 
is a Microsoft internal database function you will not see any progress indicators. The FallTrak II will display a 
message when the compression is successfully completed. 
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Import: Database 
The FallTrak II Import Database command allows you to combine data from multiple FallTrak II databases into a 
single database for reporting and group summary analysis. Each FallTrak II Database is a unique GUID. Use the 
Help, About command to view the GUID for your database. 
 
IMPORTANT: The Import Database function is used to combine multiple databases into a single FallTrak II 
Database at a central location. To upgrade an existing database to the FallTrak II2009 format, use the File, 
Upgrade command. 
Steps 

Importing Data When the Sending Sites Backup Their FallTrak II Data 
1. Each site creates a backup of their data and sends it to the central location. 
2. On the File menu, click Import, Database. 
3. Click Set Source. 
4. From the Windows File Open dialog box, select the FallTrak II Backup file submitted by the site. 
5. Click UnZip Data to expand the FallTrak II Backup file. 
6. Click Import Data to import the submitted data into the main FallTrak II database. 

Importing Data When the Sending Sites Copy Their FallTrak II Data 
1. Each site copies the FallTrak II Data Files to a CD-R, ZIP or other large-format storage media. 
2. On the File menu, click Import, Database. 
3. Click Set Source. 
4. From the Windows File Open dialog box, select the User FallTrak II.MDB file submitted by the site. 
5. Click Import Data to import the submitted data into the main FallTrak II database. 

Screen 

 
Figure 41 Import Database 

Options 

Options Definition 

Set Source Point to the source media (CD, ZIP disk) containing the FallTrak II Backup data. 

UnZip Data UnZip a FallTrak II Backup file. 

Import Data Read the backup data into the database. 
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Import: Protocols 
The FallTrak II Import Protocols command allows you to import System Protocols from other users into your 
FallTrak II System. 

Steps 
1. On the File menu, click Import, Protocols. 
2. Each FallTrak II protocol has a unique code. The FallTrak II will ask if you want to Overwrite duplicate 

protocols, e.g. those with the same unique code. 
a. Yes: Import the protocol, overwriting the existing system protocol with the imported protocol. 

Note: No changes are made to tests which were previously run with the protocol. 
b. No: Do not import the protocol. 

3. From the Windows File Open dialog box, select the Protocols2009.MDB file and click the Open button. 
4. The FallTrak II will import the System Protocols to your database. 
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Exporting Data 
The FallTrak II allows you to Export real-time data to an Excel Spreadsheet or to a Text File. 

Steps 
1. Select the Patient whose data you want to export. 
2. On the Database menu, click Export Data. 
3. Click the Test/Exercise record you want to export. 
4. Click Excel to export the data to an Excel Spreadsheet. Click Text to export the data to a text file. 

Excel File Format 
The FallTrak II will create an Excel Workbook containing one sheet for each test/exercise set. Each sheet will 
contain the real-time time, torque and position data along with a plot of the torque and position data vs. time. 

Text File Format 
The FallTrak II will create a text file for each test speed and side run. The files are placed in the FallTrak II/Export 
folder with the file name identifying the specific patient and test. 
 
Patient Name, Date/Time of Test, Speed, Repetitions, Protocol Set Number, ".CSV" 
 
The Protocol Set Number indicates the set in the protocol, because you can create a protocol with multiple sets of 
the same speed and number of repetitions. For example, if we tested Rob Potash on September 13 at 60 deg/sec 
15 repetitions and 180 deg/sec 15 repetitions, the FallTrak II would create the following files. 
 

Potash_ Robert L 9_12_98 7_48_40 AM 60 5 Right 0.CSV 
Potash_ Robert L 9_12_98 7_48_40 AM 60 5 Left 0.CSV 
Potash_ Robert L 9_12_98 7_48_40 AM 180 15 Right 1.CSV 
Potash_ Robert L 9_12_98 7_48_40 AM 180 15 Left 1.CSV 

 
These tests can be read into Excel, by double-clicking the filename. 
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Submitting a Test to MedTrak VNG 
The FallTrak II allows you to submit tests to MedTrak VNG via for review. 

Steps 
1. Select the Patient whose data you want to submit. 
2. On the Database menu, click Database, Submit Test. 
3. Click the Browse button to set the destination for the submitted test file. If you do not have internet 

access from the computer, you can set the destination to a USB key and e-mail the test to MedTrak VNG 
from a different computer. 

4. Select the Test or Exercise you want to submit. 
5. Click the Start button to create the Submit file. 
6. E-mail the file to scott@medtrakvng.com. Add a description of the issue you would like MedTrak VNG to 

review in the body of the e-mail when submitting the test. 
 
Note: Patient identifying information (Name, ID, Doctor, etc.) is removed from the test before it is submitted to 
MedTrak VNG. In addition the Submit file is encrypted and password protected. 
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System Protocols 
The FallTrak II allows you to define System Protocols. System Protocols can be selected for use by any patient. 

Screen 

 
Figure 42 System Protocol Editor 

Editing a System Protocol 
1. From the Utilities menu, select Protocol Editor. 
2. In the Test Pattern area, select the pattern you want to add/edit a protocol for. The FallTrak II will display 

all available system protocols for the selected Pattern in the Protocol Name area. 
3. Select Testing or Exercise to edit the appropriate protocol. 
4. Single-click the protocol name. The FallTrak II will display all sets in the selected protocol. 
5. Select Edit to edit the selected protocol. 

Adding a System Protocol 
1. From the Utilities menu, select Protocol Editor. 
2. In the Test Pattern area, select the pattern you want to add/edit a protocol for. The FallTrak II will display 

all available system protocols for the selected Pattern in the Protocol Name area. 
3. Select Testing or Exercise to edit the appropriate protocol. 
4. Select Add to add a new protocol. 

Deleting a System Protocol 
1. From the Utilities menu, select Protocol Editor. 
2. In the Test Pattern area, select the pattern you want to add/edit a protocol for. The FallTrak II will display 

all available system protocols for the selected Pattern in the Protocol Name area. 
3. Select Testing or Exercise to edit the appropriate protocol. 
4. Single-click the protocol name. The FallTrak II will display all sets in the selected protocol. 
5. Select Delete to delete the selected protocol. 

Printing Protocols 
1. From the Utilities menu, select Protocol Editor. 
2. Click the Print button. 
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Interactive Protocols 
The FallTrak II allows you to define a number of interactive protocols. The interactive protocols are described in 
detail below. The procedures for adding, editing and deleting interactive protocols are similar for each protocol 
type. 

Adding a New Protocol 
1. From the Utilities menu, select Interactive Feedback Editor, Protocol Type. 
2. Click the Add button. 
3. Enter the protocol values. The FallTrak II automatically updates the feedback display. 
4. In the area above the display enter a Descriptive Name for the protocol. 

Editing a Protocol 
1. From the Utilities menu, select Interactive Feedback Editor, Protocol Type. 
2. In the table on the left, click the Protocol Name you want to edit. 
3. Enter the protocol values. The FallTrak II automatically updates the feedback display. 
4. In the area above the display enter a Descriptive Name for the protocol. 

Deleting a Protocol 
1. From the Utilities menu, select Interactive Feedback Editor, Protocol Type. 
2. In the table on the left, click the Protocol Name you want to delete. 
3. Click the Delete button. 

Protocol Editor: Roadway 

 
Figure 43 Protocol Editor: Roadway 

 

Parameter Definition (in seconds) 

Relax Time Time during which the patient relaxes at the start of a repetition. 

Raise Time Time during which the patient is moving toward the ROM target in Isotonic mode or 
the Torque target in Isometric mode. 

Hold Time Time during which the patient holds at the ROM target in Isotonic mode or the Torque 
target in Isometric mode. 

Lower Time Time during which the patient is relaxing and moving toward the starting position in 
Isotonic mode or not generating torque in Isometric mode. 
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FallTrak II Data File Locations 

Files 
The FallTrak II uses an Access Databases and a collection of real-time data files to store the Balance data. 

FileName Description 

User FallTrak II.MDB Patient names, demographic information, dynamometer settings, protocols, and 
pointers to the real-time data files. 

User 
Calibration2015.MDB 

Dynamometer calibration and verification data. 

User Error 
Log2015.MDB 

Log of Errors reported by the FallTrak II System. 

Results2015.MDB Exported Group Summary data. 

*.H09 Real-time data files containing the torque and position data collected during each test 
and exercise set. 

Letter.Doc Narrative Report merge document. 

Letter-IsoM.Doc Isometric Narrative Report merge document. 

File Locations 

Windows8, Windows7, Vista 

FileName Location 

MDB Files C:\Users\Public\Public Documents\MedTrak VNG\FallTrak II 

*.H09 files C:\Users\Public\Public Documents\MedTrak VNG\FallTrak II\Data and all sub-folders. 

Letter*.Doc C:\Users\Public\Public Documents\MedTrak VNG\FallTrak II\Letter 

Exported Text Files C:\Users\Public\Public Documents\MedTrak VNG\FallTrak II\Export 

WindowsXP 

FileName Location 

MDB Files C:\Documents and Settings\All Users\Shared Documents\MedTrak VNG\FallTrak II 

*.H09 files C:\Documents and Settings\All Users\Shared Documents\MedTrak VNG\FallTrak 
II\Data and all sub-folders. 

Letter*.Doc C:\Documents and Settings\All Users\Shared Documents\MedTrak VNG\FallTrak 
II\Letter 

Exported Text Files C:\Documents and Settings\All Users\Shared Documents\MedTrak VNG\FallTrak 
II\Export 

Windows98 

FileName Location 

MDB Files C:\Program Files\MedTrak VNG\FallTrak II 

*.H09 files C:\Program Files\MedTrak VNG\FallTrak II\Data and all sub-folders. 

Letter*.Doc C:\Program Files\MedTrak VNG\FallTrak II\Letter 

Exported Text Files C:\Program Files\MedTrak VNG\FallTrak II\Export 
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Users 
The FallTrak II program allows you to setup user accounts which include passwords and administrative privileges. 

Steps 
1. From the File menu, select Setup Users, Setup. 

Adding a New User 

1. Click the Add button. 

Field Description 

Display Name The therapist's name recorded in the access log. 

Username The therapist's login name. 

Password The therapist's login password. Note: Passwords are case sensitive. 

Administrator Only administrators can access the File, Setup Users function. 

Editing an Existing User 

1. Select the user. 
2. Click the Edit button. 

Deleting an Existing User 

1. Select the user. 
2. Click the Delete button. 

Screen 

 
Figure 44 Setup Users 

Options 

Field Description 

Users Must Login When the FallTrak II starts, the user must enter their username and password. 

Track Patient Access Record the therapist name, patient name and date/time when a patient is selected. 

Add Add a new user 

Edit Edit the selected user's record. 

Delete Delete the selected user. Note: Deleting the selected user removes them from the 
Login options. All recorded database access is retained after the user is deleted. 

 
The selected user is deleted from the database. No delete confirmation is requested. Note: Deleting the selected 
user removes them from the Login options. All recorded database access is retained after the user is deleted. 

Login 

Steps 

1. If Users Must Login is selected, the FallTrak II will display the Login screen at startup. 



300921 FallTrak II Balance User Manual.docx  Page 87 of 100 

2. Use the File, Setup Users, Login command to change the logged-in user without re-starting the FallTrak II,  

Screen 

 
Figure 45 Login 

Printing an Access Log 
1. From the File menu, select Report, Access Log. 
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PREFERENCES 
The FallTrak II File, Preferences command allows you to customize the operation of your FallTrak II System. The 
Preferences dialog box is divided into four tabs: General, Data Analysis, Reporting, and Balance. 
 

Language 
The FallTrak II is available in a number of languages. To set the language: 

Steps 
1. On the File menu, click Preferences. 
2. Click the General tab. 
3. Select the Language. 
4. Click the OK button. 
5. Exit and re-start the FallTrak II program to switch to the new language. 

 
Note: The Windows Operating System must include the fonts required to display the selected language. Selecting 
Japanese on an English version of Windows will display ??? for the text as the Japanese fonts are not available on 
English Windows systems. 

Touch Screen Display 
The FallTrak II can increase the grid sizing for use with touch screen monitors. 

Steps 
1. On the File menu, click Preferences. 
2. Click the General tab. 
3. Set the Touch Screen option. 

 

FallTrak II Interface Type 
Selects the type of interface (Demo, USB Port) used to connect to the FallTrak II. 

Steps 
1. On the File menu, click Preferences. 
2. Click the General tab. 
3. Select the Interface. 

Options 

Option Description 

None, run program 
in Demo mode 

This is used if you want to evaluate the FallTrak II program before installation on a 
MedTrak VNG. The FallTrak II will simulate the Balance System allowing you to test all 
FallTrak II functions. 

USBCOMM Connect to the Balance Platform. 

Use Sound to Count Repetitions 
The FallTrak II can count repetitions through the PC's speakers during testing and exercise. 

Steps 
1. On the File menu, click Preferences. 
2. Click the Feedback tab. 
3. Click on Use sound to count repetitions. 
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Reset Torque Scales for Each Set 
The FallTrak II auto-scales the feedback display during testing and exercise. The very first time a patient is tested, 
the FallTrak II starts with a 20 ft-lbs scale. If the patient exceeds 20 ft-lbs, the FallTrak II moves to a 50 ft-lbs scale. 
The FallTrak II continues with 100, 200, and 500 ft-lbs scales until the best scale for the patient is found. This best 
value is stored in the FallTrak II database. The next time the patient is tested, the FallTrak II starts with best value. 
 
Because of the potential strength difference between involved and un-involved limbs and different test speeds in a 
protocol, some clinicians prefer to have the FallTrak II find the best torque scale for each set. 

Steps 
1. On the File menu, click Preferences. 
2. Click the Feedback tab. 
3. Check Reset torque scales for each set to have the FallTrak II find the best torque scale for each set. Clear 

Reset torque scales for each set to have the FallTrak II find the best torque scale for the patient and apply 
it to all sets. 

Report Heading 
The FallTrak II allows you to specify a heading (typically your clinic name and address) to be printed at the top of 
each report. 

Steps 
1. On the File menu, click Preferences. 
2. Click the Reporting tab. 
3. Enter the Report Heading. 

Units 
The FallTrak II supports US and Metric units. 

Steps 
1. On the File menu, click Preferences. 
2. Click the Reporting tab. 
3. In the Units section, select US Units or Metric Units. 

Options 

Data US Metric 

Height inches centimeters 

Weight pounds kilograms 

Torque Limit Foot-pounds newton-meters 

Torque  Foot-pounds newton-meters 

Work Foot-pounds  newton-meters 

Limits of Stability Normative Values 
The FallTrak II allows you to specify normative values for the Limits of Stability test. 

Steps 
1. On the File menu, click Preferences. 
2. Click the Balance tab. 
3. Enter the Normative Values for each target. Note: The center target is the Normative Value for the Overall 

Score. 

Stability Hold Time 
The FallTrak II allows you to specify default Hold Time for the Stability Test used in the Dashboard. 
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Steps 
1. On the File menu, click Preferences. 
2. Click the Balance tab. 
3. Enter the Hold Time value. 

Stability Goal 
The FallTrak II allows you to specify the Normative Value for the Stability Goal. 

Steps 
1. On the File menu, click Preferences. 
2. Click the Balance tab. 
3. Enter the Stability Goal value. 

Weight Bearing Display 
The FallTrak II allows you to specify the Percent Right/Left or the Force Right/Left for the Weight-Bearing display. 

Steps 
1. On the File menu, click Preferences. 
2. Click the Balance tab. 
3. In the Weight Bearing area, select Display % or Display Weight. 
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Measured Parameters 

Sensor Layout 

Force Platform Mode 
The balance sensors are arranged as follows: 

G[1]  FRONT G[0] 

  (0,0)   

G[3]  BACK G[2] 

<---------------Lx------------------> 
The board dimensions are defined as 

Parameter Definition 

Lx Distance from G[1] to G[0] 

Ly Distance from G[1] to G[3] 

Tilt Mode 
The Tilt Sensor is a single device which provides tilt measurement in the X and Y axes. 

Patient Center of Mass (Force Platform Mode) 
The Center of Mass for a patient is defined as 55% of their height. 

Weight (Force Platform Mode) 
The patient weight is computed as the sum of the four gauges 

𝑊𝐸𝐼𝐺𝐻𝑇 = ∑ 𝐺[𝑛]

3

𝑛=0

 

Center of Pressure – Balance Platform (Force Platform Mode) 
The Center of Pressure on the board is computed as follows: 
 

𝑃𝐿𝐴𝑇𝐹𝑂𝑅𝑀_𝐶𝑂𝑃𝑋 = (
𝐺[0] + 𝐺[2]

𝑊𝐸𝐼𝐺𝐻𝑇
) ∗ 𝐿𝑋 − 

𝐿𝑋

2
  

 

𝑃𝐿𝐴𝑇𝐹𝑂𝑅𝑀_𝐶𝑂𝑃𝑌 = (
𝐺[0] + 𝐺[1]

𝑊𝐸𝐼𝐺𝐻𝑇
) ∗ 𝐿𝑌 − 

𝐿𝑌

2
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Foot Position 

 
11 

 

G  (0,A) G 

 
11 

 

The platform is arranged with 0.75” grid spacing. 
 
X-Axis locations are specified as a letter running from “A” at the center of the board to “G” at each edge of the 
board. 
 
Y-Axis locations are specified as a number running from 0 at the center of the board to 11 at each edge of the 
board. 
 
The Foot Offset (in inches from (0,0) at the center of the board) is computed as follows: 
 

𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇𝑋 = (𝐹𝑂𝑂𝑇_𝐿𝑂𝐶𝐴𝑇𝐼𝑂𝑁𝑋 − 11) ∗ 𝐺𝑅𝐼𝐷_𝑆𝑃𝐴𝐶𝐼𝑁𝐺 
 

𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇𝑌 = (𝐴𝑆𝐶(𝐺𝑅𝐼𝐷_𝐿𝑂𝐶𝐴𝑇𝐼𝑂𝑁𝑌) − 𝐴𝑆𝐶("𝐺")) ∗ 𝐺𝑅𝐼𝐷_𝑆𝑃𝐴𝐶𝐼𝑁𝐺  
 
Note: ASC is the computer function which converts the letter to a numeric code so: 
 

𝐴𝑆𝐶("G") − 𝐴𝑆𝐶("𝐸") = 2 
 

Center of Pressure - Patient (Force Platform Mode) 
We need to adjust the measured COP relative to the patient’s COP, not the Platform’s COP. In this way when the 
patient is balanced the FallTrak II will display the COP at (0,0) on the screen. We do this one of two ways: 

1. Measure the Gauge Output when the therapist says the patient is in a neutral (Anatomical  Zero) position. 
2. Compute the AZ based on the Patient’s Foot Offset from the board COP. 

Anatomical Zero Based 
If the therapist sets a Patient AZ, the FallTrak II uses the AZ to compute the patient Center of Pressure. 
The FallTrak II assumes the feet are equally-spaced along the X-Axis from the centerline of the board. 
 

𝑃𝐴𝑇𝐼𝐸𝑁𝑇_𝐶𝑂𝑃𝑋 = 𝑃𝐿𝐴𝑇𝐹𝑂𝑅𝑀_𝐶𝑂𝑃𝑋 −  𝑃𝐴𝑇𝐼𝐸𝑁𝑇_𝐴𝑍_𝐶𝑂𝑃𝑋  
 

𝑃𝐴𝑇𝐼𝐸𝑁𝑇_𝐶𝑂𝑃𝑌 = 𝑃𝐿𝐴𝑇𝐹𝑂𝑅𝑀_𝐶𝑂𝑃𝑌 −  𝑃𝐴𝑇𝐼𝐸𝑁𝑇_𝐴𝑍_𝐶𝑂𝑃𝑌  

Foot Position Based 
If an AZ is not set, the FallTrak II uses the patient foot position to compute the Center of Pressure. The FallTrak II 
computes the Foot Offset for the Y-Axis as the average offset from (0,0) of the patient’s Right and Left side 
mandibular bones. 
 

Axis Location 

X Midway between their feet 

Y In-line with their mandibular bone 

 
𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇𝑋 = 0 
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𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇𝑌 =  (
𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇𝑅𝐼𝐺𝐻𝑇 + 𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇𝐿𝐸𝐹𝑇

2
) 

 
𝑃𝐴𝑇𝐼𝐸𝑁𝑇_𝐶𝑂𝑃𝑋 = 𝑃𝐿𝐴𝑇𝐹𝑂𝑅𝑀_𝐶𝑂𝑃𝑋  

 
𝑃𝐴𝑇𝐼𝐸𝑁𝑇_𝐶𝑂𝑃𝑌 = 𝑃𝐿𝐴𝑇𝐹𝑂𝑅𝑀_𝐶𝑂𝑃𝑌 − 𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇𝑌  

 
The Patient Neutral COP is the COP where they feel they are standing in a centered position. 

COP Length, Angle, Direction (Force Platform Mode) 

 
 
The COP Length is computed as: 
 

𝐶𝑂𝑃_𝐿𝐸𝑁𝐺𝑇𝐻 = √𝐶𝑂𝑃𝑋
2 +  𝐶𝑂𝑃𝑦

2 

 
The Patient’s Tilt Angle is the computed as: 
 

𝑇𝐼𝐿𝑇_𝐴𝑁𝐺𝐿𝐸 = cos−1 (
𝐶𝑂𝑃𝐿𝐸𝑁

𝑃𝐴𝑇𝐼𝐸𝑁𝑇_𝐻𝐸𝐼𝐺𝐻𝑇 ∗ 0.55
) 

 
The Patient’s Tilt Direction is the computed as: 
 

𝑇𝐼𝐿𝑇_𝐷𝐼𝑅𝐸𝐶𝑇𝐼𝑂𝑁 = tan−1 (
𝐶𝑂𝑃𝑋

𝐶𝑂𝑃𝑌

) 

Displayed Tilt Angle, Tilt Direction (Force Platform Mode) 
The displayed COP is computed as a projection of the Tilt Angle and Direction onto the platform. For example if the 
patient was tilted 6 degrees directly to the right, the FallTrak II would display the cursor on the 6 degree circle at 
3:00. 
 

𝑃𝑅𝑂𝐽𝐸𝐶𝑇𝐸𝐷_𝐶𝑂𝑃𝑋 = 𝑇𝐼𝐿𝑇_𝐴𝑁𝐺𝐿𝐸 ∗  sin(𝑇𝐼𝐿𝑇_𝐷𝐼𝑅𝐸𝐶𝑇𝐼𝑂𝑁) 
 

𝑃𝑅𝑂𝐽𝐸𝐶𝑇𝐸𝐷_𝐶𝑂𝑃𝑌 = 𝑇𝐼𝐿𝑇_𝐴𝑁𝐺𝐿𝐸 ∗  cos(𝑇𝐼𝐿𝑇_𝐷𝐼𝑅𝐸𝐶𝑇𝐼𝑂𝑁) 

Displayed R/L and A/P Tilt Angle (Tilt Mode) 
The displayed Right/Left and Anterior/Posterior Tilt Angles are read directly from the Tilt Sensor and indicate the 
Balance Platform angle. 
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𝑃𝑅𝑂𝐽𝐸𝐶𝑇𝐸𝐷_𝐶𝑂𝑃𝑋 = 𝑇𝐼𝐿𝑇_𝐴𝑁𝐺𝐿𝐸𝑅/𝐿 

 
𝑃𝑅𝑂𝐽𝐸𝐶𝑇𝐸𝐷_𝐶𝑂𝑃𝑌 = 𝑇𝐼𝐿𝑇_𝐴𝑁𝐺𝐿𝐸𝐴/𝑃 

Percent Weight Bearing (Force Platform Mode) 

Right/Left 
The Right/Left Weight Bearing values are computed as: 
 

𝑃𝐶𝑇_𝑅𝐼𝐺𝐻𝑇 =  𝐴𝐵𝑆 (
𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇_𝐿𝐸𝐹𝑇𝑋 − 𝐶𝑂𝑃𝑋

𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇_𝐿𝐸𝐹𝑇𝑋 − 𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇_𝑅𝐼𝐺𝐻𝑇𝑋

) ∗ 100 

 
𝑃𝐶𝑇_𝐿𝐸𝐹𝑇 = 100 − 𝑃𝐶𝑇_𝑅𝐼𝐺𝐻𝑇 

The value is limited to 100%. Since the centerline of the patient’s foot is recorded, it is possible they can shift all of 
their weight to the outer edge of their right foot which would cause the PCT_RIGHT to be greater than 100% since 
the COPX would be outside the FOOT_OFFSET_RIGHT. 

Front/Back 
The Front/Back Weight Bearing values are computed as: 
 

𝑃𝐶𝑇_𝐹𝑅𝑂𝑁𝑇 =  𝐴𝐵𝑆 (
𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇_𝐿𝐸𝐹𝑇𝑋 − 𝐶𝑂𝑃𝑌

𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇_𝐿𝐸𝐹𝑇𝑋 − 𝐹𝑂𝑂𝑇_𝑂𝐹𝐹𝑆𝐸𝑇_𝑅𝐼𝐺𝐻𝑇𝑋

) ∗ 100 

 
𝑃𝐶𝑇_𝐵𝐴𝐶𝐾 = 100 − 𝑃𝐶𝑇_𝐹𝑅𝑂𝑁𝑇 

 
Note: Since the patient is not shifting from one foot to the other in the Y-Axis there is no true percent weight 
bearing. The FallTrak II uses the Right/Left foot positions for these calculations so an equivalent shift Front/Back in 
the COP results in the same reported percentage as the Right/Left. 

Limits of Stability Score (Force Platform Mode and Tilt Mode) 
The ratio of the length a straight line between to targets to the length of the path traversed by the patient 
between the targets. 
 
 
 
 
 
 
 
 
 
 
 

𝐿𝑂𝑆𝑆𝐶𝑂𝑅𝐸 = (
𝐿𝐸𝑁𝐺𝑇𝐻_𝑆𝑇𝑅𝐴𝐼𝐺𝐻𝑇

𝐿𝐸𝑁𝐺𝑇𝐻_𝑃𝐴𝑇𝐼𝐸𝑁𝑇
) ∗ 100 

Stability Score (Force Platform Mode and Tilt Mode) 
The ratio of the percent of time the patient was on a target to the time the target was active. 
 

𝑆𝑇𝐴𝐵𝐼𝐿𝐼𝑇𝑌_𝑆𝐶𝑂𝑅𝐸 = (
𝑇𝐼𝑀𝐸_𝑂𝑁_𝑇𝐴𝑅𝐺𝐸𝑇

𝑇𝐼𝑀𝐸_𝑇𝐴𝑅𝐺𝐸𝑇_𝐴𝐶𝑇𝐼𝑉𝐸
) ∗ 100 
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Mobility Score (Force Platform Mode and Tilt Mode) 
The ratio of the percent of time the patient was on the target to the duration of the test. 
 

𝑀𝑂𝐵𝐼𝐿𝐼𝑇𝑌_𝑆𝐶𝑂𝑅𝐸 = (
𝑇𝐼𝑀𝐸_𝑂𝑁_𝑇𝐴𝑅𝐺𝐸𝑇

𝑇𝑂𝑇𝐴𝐿_𝑇𝐸𝑆𝑇_𝑇𝐼𝑀𝐸
) ∗ 100 

CTSIB Score (Force Platform Mode) 
The CTSIB Score is computed as the ratio between the Patient’s 95% confidence interval major axis length and the 
standard 6.25 degree tilt axis length. 
 
The COP_LENGTH is defined as: 
 

𝑅𝐴𝐷𝐼𝑈𝑆 = √𝐶𝑂𝑃𝑋
2 + 𝐶𝑂𝑃𝑦

2 

 
Compute the COP_LENGTH for 6.25 degrees of tilt. 
 

𝐶𝑂𝑃_𝐿𝐸𝑁𝐺𝐻6.25 = 0.55 ∗ 𝑃𝐴𝑇𝐼𝐸𝑁𝑇𝐻𝐸𝐼𝐺𝐻𝑇 ∗ sin(6.25) 
 
Compute the 95% confidence interval MAJOR_AXIS. Note: The 95% Confidence Interval calculations are complex 
and not included in the User Manual. The equations can be found on a number of websites. 
 

Compute the STABILITY_SCORE as the ratio between the Patient’s MAJOR_AXIS length and the 6.25 COP_LENGTH. 
 

𝑆𝑇𝐴𝐵𝐼𝐿𝐼𝑇𝑌_𝑆𝐶𝑂𝑅𝐸 = (
𝐶𝑂𝑃_𝐿𝐸𝑁6.25 − 95% 𝐶𝑂𝑁𝐹𝐼𝐷𝐸𝑁𝐶𝐸 𝐼𝑁𝑇𝐸𝑅𝑉𝐴𝐿𝑀𝐴𝐽𝑂𝑅_𝐴𝑋𝐼𝑆

𝐶𝑂𝑃_𝐿𝐸𝑁6.25

) ∗ 100 

Excel Export Fields 
The following fields are exported to Excel. 

Field Units Definition 

Status  Program Status (See below)  

Time Seconds Elapsed Time 

Gauge[0..3] Pounds The Force on each strain gauge 

Platform (X, Y) Inches The Center of Pressure on the Balance Platform where (0,0) is the center of the 
platform. 

Weight Pounds The patient’s weight. 

Patient COP 
(X,Y) 

Inches The patient’s Center of Pressure in inches where (0,0) is the patient’s center of 
balance. 

Patient COP Len Inches The length in inches of the patient’s COP. 

Tilt Angle Degrees The patient’s Tilt Angle in Degrees 

Tilt Direction Degrees The Direction of the patient Tilt Angle where 0 is 12:00 with values increasing in a 
clockwise direction. 

Tilt Projection 
(X, Y) 

Degrees The patients Tilt Angle and Direction projection in degrees where (0,0) is the 
patient’s center of balance. 

Pct Right % The Percent of Body Weight on the Right foot. 

Pct Front % The percentage of Body Weight in the Forward direction. 

Program Status fields. 

Value 
(HEX) 

Definition 

0020 Isometric mode: Patient not in target area, display frozen. 
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0040 Next external stimulus is presented to patient. First point when the target moved to the new 
location. 

0080 The challenge has begun. Used to ignore data at the front of a test where the patient is getting 
ready to start. 

0100 Patient is within the target area. 

0200 Patient was on target the required amount of time so we can move-on to the next target. 

0400 Patient was unable to reach the target so therapist moved on to the next target. 

7800 Four bits used to indicate active target number (0-15). 

8000 Patient fell during the test. 
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ELECTROMAGNETIC COMPATIBILITY 

Table 1 

Guidance and Manufacturer’s Declaration – Emissions Guidance and Manufacturer’s Declaration – 
Electromagnetic Emissions 
 
The FallTrak II Balance is intended for use in the electromagnetic environment specified below. The customer or 
user of the FallTrak II should ensure that it is used in such an environment. 
 

Emissions Test Compliance Electromagnetic Environment – Guidance 

RF Emissions 
CISPR 11 

Group 1 The FallTrak II uses RF energy only for its internal function. Therefore, its 
RF emissions are very low and are not likely to cause any interference in 
nearby electronic equipment. 

RF Emissions 
CISPR 11 

Class A or B B 

Harmonics IEC 
61000-3-2 

Class A,B,C,D or 
N/A 

A 

Flicker IEC 
61000-3-3 

Complies or N/A Complies 

 [See 6.8.3.201 a) 3) 
and Figure 201] 

The FallTrak II is suitable for use in all establishments, including 
domestic, and those directly connected to the public low-voltage power 
supply network that supplies buildings used for domestic purposes.  

RF Emissions 
CISPR 14-1 

Complies The FallTrak II is not suitable for interconnection with other equipment. 

RF Emissions 
CISPR 15 

Complies The FallTrak II is not suitable for interconnection with other equipment.  
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Table 2 

Guidance and Manufacturer’s Declaration – Immunity All Equipment and Systems Guidance and 
Manufacturer’s Declaration – Electromagnetic Immunity 
 
The FallTrak II is intended for use in the electromagnetic environment specified below. The customer or user of the 
FallTrak II should ensure that it is used in such an environment. 
 

Immunity Test EN/IEC 60601 
Test Level 

Compliance 
Level 

Electromagnetic Environment – Guidance  

ESD EN/IEC 
61000-4-2 

 ±6kV Contact 
±8kV Air 

As specified Floors should be wood, concrete or ceramic tile. If 
floors are synthetic, the r/h should be at least 30%  

EFT EN/IEC 
61000-4-4 

 ±2kV Mains 
±1kV I/Os 

As specified Mains power quality should be that of a typical 
commercial or hospital environment. 

Surge EN/IEC 
61000-4-5 

±1kV Differential 
±2kV Common 

As specified Mains power quality should be that of a typical 
commercial or hospital environment.  

Voltage 
Dips/Dropout 
EN/IEC 61000-4-
11 

>95% Dip for 
0.5 Cycle 
 
60% Dip for 
5 Cycles 
 
30% Dip for 
25 Cycles 
 
>95% Dip for 
5 seconds 

As specified 
 
 
As specified 
 
 
As specified 
 
 
As specified 

Mains power quality should be that of a typical 
commercial or hospital environment. If the user of the 
FallTrak II expects dips as specified and the FallTrak II 
requires continued operation during power mains 
interruptions, it is recommended that the FallTrak II be 
powered from an uninterruptible power supply or 
battery. 

Power 
Frequency 
50/60Hz EN/IEC 
61000-4-8 

3A/m As specified Power frequency magnetic fields should Magnetic Field 
be that of a typical commercial or hospital 
environment. 
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Table 3 

Guidance and Manufacturer’s Declaration – Emissions Equipment and Systems that are NOT Life-
supporting Guidance and Manufacturer’s Declaration – Electromagnetic Immunity 
 
The FallTrak II is intended for use in the electromagnetic environment specified below. The customer or user of the 
FallTrak II should ensure that it is used in such an environment. 
 

Immunity Test EN/IEC 60601 Test 
Level 

Compliance 
Level 

Electromagnetic Environment – Guidance  

 
 
 
Conducted RF 
EN/IEC 61000-4-6 
 
 
Radiated RF 
EN/IEC 61000-4-3 

 
 
 
3 Vrms 
150 kHz to 80 MHz 
 
 
3V/m 
80 MHz to 2.5 GHz  

 
 
 
(V1)Vrms 
 
 
 
(E1)V/m 

Portable and mobile communications equipment 
should be separated from the FallTrak II360 by no less 
than the distances calculated/listed below: 
D=(3.5/V1)(Sqrt P) D=(3.5/E1)(Sqrt P) 80 to 800 MHz 
D=(7/E1)(Sqrt P) 800 MHz to 2.5 GHz where P is the 
max power in watts and D is the recommended 
separation distance in meters. Field strengths from 
fixed transmitters, as determined by an 
electromagnetic site survey, should be less than the 
compliance levels (V1 and E1). Interference may 
occur in the vicinity of equipment containing a 
transmitter. 
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Table 4 

Recommended Separation Distances between portable and mobile RF Communications equipment 
and the FallTrak II Balance Equipment and Systems that are NOT Life-supporting 
 
The FallTrak II is intended for use in the electromagnetic environment in which radiated disturbances are 
controlled. The customer or user of the FallTrak II can help prevent electromagnetic interference by maintaining a 
minimum distance between portable and mobile RF Communications Equipment and the FallTrak II as 
recommended below, according to the maximum output power of the communications equipment. 
 

Max Output Power 
(Watts) 

Separation (m) 150kHz to 
80MHz D=(3.5/V1)(Sqrt P) 

Separation (m) 80 to 
800MHz D=(3.5/E1)(Sqrt 

P) 

Separation (m) 800MHz 
to 2.5GHz D=(7/E1)(Sqrt 

P) 

0.01 .1166 .1166 .2333 

0.1 .3689 .3689 .7378 

1 1.1666 1.1666 2.3333 

10 3.6893 3.6893 7.3786 

100 11.6666 11.6666 23.3333 

 


